Thank you for purchasing FUJIFILM Science Lab Image Gauge Ver. 4.0

Before using this software, please be aware of the following important items.

Regarding the use of Science Lab 2001 Image Gauge software:
When you first started using this software, you agreed to the usage conditions specified below, and Fuji Photo Film Co., Ltd. granted you a license to use the Science Lab 2001 Image Gauge software.
The ownership rights to the software belong to Fuji Photo Film Co., Ltd. and Kohshin Graphics Systems Inc. Part of the ownership rights to this software belongs to ALTURA SOFTWARE, INC. In keeping, this software is not something that is sold to you but something that Fuji Photo Film Co., Ltd. grants you a license to use. The recording media is yours, but the ownership rights to the software remain with Fuji Photo Film Co., Ltd.

LICENSE TERMS
1) You are granted the use of Science Lab 2001 Image Gauge for a single CPU or a single unit within multiple CPUs. Hence, in a computer network environment, a separate Science Lab 2001 Image Gauge license will be required for each unit that will be using the software.
2) You are allowed to copy Science Lab 2001 Image Gauge onto different media for backup and program execution purposes.

USAGE LIMITATION
1) No copying, modification or transfer of Science Lab 2001 Image Gauge other than specified by the terms of the usage license is allowed.
2) No reverse compiling or reverse assembling of Science Lab 2001 Image Gauge done for the purpose of turning Science Lab 2001 Image Gauge into a readable format is allowed.
3) No lending or distribution of Science Lab 2001 Image Gauge or a part thereof for profit is allowed.
4) No derivative copyrighted product can be produced from Science Lab 2001 Image Gauge, or modifications of it, or in conjunction with other software.

NOTES
1) Reproduction of parts or all of the contents of this manual without permission is prohibited.
2) The contents of this manual are subject to change without notice.
3) This manual has been prepared with utmost care. However, if you have any questions or find errors, omissions, etc., please contact us.
4) We will not be liable for any effects incurred from the use of this device.

Copyright Reserved

<Reprint and/or reproduction of parts or whole of this manual is prohibited.>

Copyright© 1998-1999 by Fuji Photo Film Co., Ltd.

Microsoft is a registered trademark of Microsoft Corporation in the U.S.
Windows®, Windows® 95, Windows® 98 and Windows NT® are registered trademarks of Microsoft Corporation in the U.S.
Pentium is a registered trademark of Intel Corporation in the U.S.
Other company names and product names mentioned in this document are the trademarks or registered trademarks of those companies.
1 "Portions of this product are copyright ©1991-1997 Altura Software Inc. All rights reserved."

2 "COMPANY’S LICENSOR (S) MAKES NO WARRANTIES, EXPRESS OR IMPLIED, INCLUDING WITHOUT LIMITATION THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE, REGARDING THE SOFTWARE. COMPANY'S LICENSOR (S) DOES NOT WARRANT, GUARANTY, OR MAKE ANY REPRESENTATIONS REGARDING THE USE OR THE RESULTS OF THE USE OF THE SOFTWARE IN TERMS OF ITS CORRECTNESS, ACCURACY, RELIABILITY, CURRENTNESS, OR OTHERWISE. THE ENTIRE RISK AS TO THE RESULTS AND PERFORMANCE OF THE SOFTWARE IS ASSUMED BY YOU. THE EXCLUSION OF THE IMPLIED WARRANTIES IS NOT PERMITTED BY SOME STATES. THE ABOVE EXCLUSION MAY NOT APPLY TO YOU."

3 "IN NO EVENT WILL COMPANY’S LICENSOR (S), AND THEIR DIRECTORS, OFFICERS, EMPLOYEES, OR AGENTS (COLLECTIVELY "COMPANY’S LICENSOR") BE LIABLE TO YOU FOR ANY CONSEQUENTIAL, INCIDENTAL, OR INDIRECT DAMAGES (INCLUDING DAMAGES FOR LOSS OF BUSINESS PROFITS, BUSINESS INTERRUPTION, LOSS OF BUSINESS INFORMATION, AND THE LIKE) ARISING OUT OF THE USE OF, OR INABILITY TO USE, THE SOFTWARE EVEN IF COMPANY’S LICENSOR HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. BECAUSE SOME STATES DO NOT ALLOW THE EXCLUSION OR LIMITATION OF LIABILITY FOR CONSEQUENTIAL OR INCIDENTAL DAMAGES, THE ABOVE LIMITATIONS MAY NOT APPLY TO YOU."
This equipment cannot be taken to or used in a country or area where power supply specifications differ from those in the country or area where it was originally installed.

**JAPAN**
This device is in compliance with the VCCI standards established by the conference on self-imposed control of noise interference caused by information devices for the purpose of preventing interference in commercial and industrial areas caused by Class 1 information devices (information devices to be used in commercial and industrial areas). If this device is used in residential areas adjacent to them, it may cause radio disturbance. This device must be handled correctly in accordance with this operation manual.

**United States of America**
This equipment generates, uses, and can radiate radio frequency energy and if not installed and used in accordance with the instructions manual, may cause interference to radio communications. It has been tested and found to comply with the limits for a Class A computing device pursuant to Subpart J of part 15 of FCC Rules, which are designed to provide reasonable protection against such interference when operated in a commercial environment. Operation of this equipment in a residential area is likely to cause interference in which case the user at his own expense will be required to take whatever measures may be required to correct the interference.

**Canada**
This digital apparatus does not exceed the Class A limits for radio noise emission from digital apparatus as set out in the radio interference regulations of the Canadian Department of Communications.

“Le présent appareil numérique n’émet pas de bruits radioélectriques dépassant les limites applicables aux appareils numériques de la class A prescrites dans le Règlement sur le brouillage radioélectrique édicté par le ministère des Communications du Canada.”
Contents

Part A  Before Beginning Operations

1. Image Gauge Ver. 4.0 ......................................................................................................... A–2

2. Installing/Uninstalling the Image Gauge ................................................................. A–4
   2.1 Installing the Image Gauge ...................................................................................... A–4
   2.2 Uninstalling the Image Gauge ............................................................................... A–11

Part B  Viewing an Image

1. Starting Up and Quitting this Software ................................................................. B–2
   Starting Up ................................................................................................................ B–2
   Quitting .................................................................................................................... B–3

2. Image Gauge Menu Lists ......................................................................................... B–4
   File menu .................................................................................................................. B–4
   Edit menu ................................................................................................................ B–5
   Image menu ............................................................................................................. B–5
   Analysis menu ....................................................................................................... B–6
   Windows menu ...................................................................................................... B–7
   Help menu ............................................................................................................. B–7

3. Viewing an Image ..................................................................................................... B–8
   3.1 Image Reading ..................................................................................................... B–8
   3.2 Opening an Image File ....................................................................................... B–8
   3.3 Trimming an Image .......................................................................................... B–10
   3.4 Dividing and Saving an Image ........................................................................... B–13

4. Names of the Parts of the Image Gauge Window ..................................................... B–14

5. Changing the Monitor Display .............................................................................. B–15
   5.1 Changing the Display Color ............................................................................. B–15
   5.2 Adjusting Contrast ........................................................................................... B–15
   5.3 Enhancing Contrast ......................................................................................... B–22
   5.4 Displaying an Entire Image .............................................................................. B–25
   5.5 Displaying Informations Related to Image ....................................................... B–26

6. Various Read Images ............................................................................................... B–27
Part C  Quantifying an Image

1. Four Analysis Modes ........................................................................................................ C–2
2. Using the Analysis Tools .................................................................................................. C–3
   2.1 Analysis Tools Common to Each Mode ........................................................................ C–3
       Pointer Tool ................................................................................................................... C–3
       Density Picker Tool ........................................................................................................ C–5
       Magnifying Glass Tool .................................................................................................. C–7
       Hand Tool ....................................................................................................................... C–9
   2.2 Annotation Mode ......................................................................................................... C–10
       Image Selector tool ....................................................................................................... C–10
       Text Tool ...................................................................................................................... C–13
       Arrow Tool ................................................................................................................... C–15
       Info Stamp Tool .......................................................................................................... C–16
       Scale Bar Tool .............................................................................................................. C–18
       BMP Stamp Tool ......................................................................................................... C–19
       Menu Functions Related to Annotation ....................................................................... C–21
   2.3 Quant Mode ................................................................................................................ C–23
       Rectangle Tool .............................................................................................................. C–23
       Freehand Tool ............................................................................................................. C–24
       Polygon Tool ................................................................................................................. C–26
       Oval Tool ...................................................................................................................... C–28
       Slanted Rectangle Tool ............................................................................................... C–29
       Ladder Tool ................................................................................................................... C–30
       Matrix Tool ................................................................................................................... C–33
       Free-Division Matrix Tool ........................................................................................... C–36
       Automatic Band Tool ................................................................................................... C–39
       Correcting a Ladder/Freehand Matrix ......................................................................... C–43
       Titter Plate Tool ......................................................................................................... C–44
       Magic Wands Tool ....................................................................................................... C–46
       Free Edit Tool .............................................................................................................. C–48
       Menu Functions Related to Quant ............................................................................... C–49
   Making an ROI Data File ............................................................................................... C–49
   Using Duplicate .............................................................................................................. C–51
   Saving Quantification Areas .......................................................................................... C–53
   Retrieving the Saved Quantication Areas ....................................................................... C–54
   Displaying Quant Results ............................................................................................... C–56
### 2.4 Profile/MW Mode

<table>
<thead>
<tr>
<th>Tool Name</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Line Profile Tool</td>
<td>C–57</td>
</tr>
<tr>
<td>Lane Profile Tool</td>
<td>C–58</td>
</tr>
<tr>
<td>Smile Lane Profile Tool</td>
<td>C–59</td>
</tr>
<tr>
<td>Start Line Tool</td>
<td>C–61</td>
</tr>
<tr>
<td>Automatic Lane/Band Tool</td>
<td>C–63</td>
</tr>
<tr>
<td>Band Tool</td>
<td>C–66</td>
</tr>
</tbody>
</table>

Menu Functions Related to Profile/MW

<table>
<thead>
<tr>
<th>Function</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Deleting Lane</td>
<td>C–67</td>
</tr>
<tr>
<td>Setting Lane Width</td>
<td>C–68</td>
</tr>
<tr>
<td>Setting the Peak ROI Type</td>
<td>C–69</td>
</tr>
<tr>
<td>Peak Aid Function</td>
<td>C–70</td>
</tr>
<tr>
<td>Saving the Lane</td>
<td>C–72</td>
</tr>
<tr>
<td>Retrieving the Saved Lane</td>
<td>C–73</td>
</tr>
<tr>
<td>Displaying Profiles</td>
<td>C–75</td>
</tr>
</tbody>
</table>

### 2.5 Distance Mode

<table>
<thead>
<tr>
<th>Tool Name</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Distance Tool</td>
<td>C–76</td>
</tr>
<tr>
<td>Interval Tool</td>
<td>C–78</td>
</tr>
<tr>
<td>Angle Tool</td>
<td>C–80</td>
</tr>
</tbody>
</table>

### Part D Analyzing Quantification Results

1. Analysis in Quant Mode

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Selection of Displayed Items</td>
<td>D–2</td>
</tr>
<tr>
<td>Dividing Measured Regions into Groups</td>
<td>D–4</td>
</tr>
<tr>
<td>Quant Result Operations</td>
<td>D–7</td>
</tr>
<tr>
<td>(1) Background Subtraction</td>
<td>D–7</td>
</tr>
<tr>
<td>(1)-1 When there is no group division</td>
<td>D–7</td>
</tr>
<tr>
<td>(1)-2 When there is group division</td>
<td>D–8</td>
</tr>
<tr>
<td>(2) Setting a Standard</td>
<td>D–10</td>
</tr>
<tr>
<td>(2)-1 Setting a Standard when there is no group division</td>
<td>D–10</td>
</tr>
<tr>
<td>(2)-2 Setting a Standard for Each Group</td>
<td>D–12</td>
</tr>
<tr>
<td>(3) Shortcuts for Setting Groups, Backgrounds, and Standards</td>
<td>D–13</td>
</tr>
<tr>
<td>(4) Setting Reference Values</td>
<td>D–15</td>
</tr>
<tr>
<td>(5) Setting the Calibration Curve</td>
<td>D–16</td>
</tr>
</tbody>
</table>

2. Analysis in Profile/MW Mode

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Displaying the Profile Line</td>
<td>D–20</td>
</tr>
</tbody>
</table>
2.1 Display Mode
- Sequential Switcher ........................................... D–21
- Pulldown Switcher .................................................. D–21
- Graph Slider Tool ...................................................... D–23
- Pointer Tool .............................................................. D–23
- Horizontal Magnifying Glass Tool ......................... D–24
- Vertical Magnifying Glass Tool ............................... D–25
- Hand Tool ................................................................. D–26
- Magnifying Glass Tool ............................................. D–26

2.2 Measure Mode
- Horizontal BG Tool .................................................. D–27
- Background Tool ...................................................... D–30
- Spline BG Tool ........................................................... D–33
- Integral Tool ............................................................. D–34
- Measure Profile Tool ................................................ D–36
- Density Picker Tool .................................................... D–38

Automatic Profile Background Recognition .................. D–40
Auto BG... .................................................................. D–40
Automatic Recognition of a Profile Measurement Region ........................................ D–45
Peak Search ............................................................... D–45
Setting Rf ................................................................. D–47
Measuring Distance Using the Rf Value ..................... D–48
Applying the Rf Value ................................................ D–50
Copy RF Ratio ............................................................. D–50
Setting the Profile Display Method ......................... D–52
Displaying Profile Results ....................................... D–53
Molecular Weight Measurement ................................. D–54

3. Related Menu Functions (used in both Quant and Profile) .......................... D–58
3.1 Modifying the Unit .................................................. D–58
3.2 Making Quantification Results into a File ....................... D–59
3.3 Changing the Position of the Measurement No. ....................... D–60
Part E  Printing
1. Printing an Image ............................................................................................................ E–2
   1.1 Printing with a Laser Beam Printer .......................................................................... E–2
   1.2 Printing with the PG3000, PG3500, PG4000 or PSD400 High-Image-Quality Printer .. E–9
2. Printing Quantified Results .............................................................................................. E–14
   2.1 Using Quant Result for Printing Quantified Results .................................................. E–14
   2.2 Printing Quantified Results using Profile Result ......................................................... E–15
   2.3 Printing Result Table using Distance Result ............................................................... E–15
3. Printing Profile Graph ........................................................................................................ E–16

Part F  Convenient Menu Functions to Learn
1. Opening a File ................................................................................................................ F–2
   Import File ..................................................................................................................... F–2
   Custom ............................................................................................................................ F–3
   BMP / TIFF .................................................................................................................... F–3
2. Saving BMP and TIFF Files ............................................................................................ F–4
3. File Menu ........................................................................................................................ F–6
4. Edit Menu ........................................................................................................................ F–7
5. Analysis Menu ................................................................................................................... F–7
6. Image Menu ....................................................................................................................... F–8

Index
Part A

Before Beginning Operations
1. Image Gauge Ver. 4.0

1. Image Gauge Ver. 4.0 (hereinafter referred to as "this software,") is for analyzing and quantifying the image data input from the Image Plate Reader (IP Reader) originally introduced to the market by Fuji Photo Film Co., Ltd. and for image analysis and quantification of image data in RAW format.

2. The sample screens throughout this manual have been selected and used provided that they match the functions described and the assumed selections and items that appear. In keeping, when reading the manual, adapt it to the images that you actually deal with.

3. For details on image reading, refer to the operation manual that accompany the Image Readers.

4. Use of this software has been confirmed for the following system combinations. If other combinations are used, correct software operation cannot be guaranteed.

1. Standard Hardware Configuration

* Computer main unit:
  DELL's OptiPlex GX150-933MT (CPU: Pentium II-933MHz; built-in HDD: ATA-support EIDE drive)
  Includes keyboard, keyboard cable, mouse and mouse cable.
  * Capacity of the main memory will be as follows, depending on the image type to be processed. (Figures shown between parentheses indicate maximum image size. For analysis of two or more types of image, use the maximum one.)

<table>
<thead>
<tr>
<th>Image Reader and Max. Image Size</th>
<th>Main Memory</th>
</tr>
</thead>
<tbody>
<tr>
<td>BAS-1000 (2MB), BAS-1500 (16MB)</td>
<td>64MB</td>
</tr>
<tr>
<td>BAS-2000 (64MB), BAS-3000 (12MB)</td>
<td></td>
</tr>
<tr>
<td>BAS-2500 (64MB), BAS-1800 (40MB)</td>
<td>96MB</td>
</tr>
<tr>
<td>FLA-2000 (64MB), FLA-8000 (136MB)</td>
<td></td>
</tr>
<tr>
<td>BAS-5000 (160MB)</td>
<td>224MB</td>
</tr>
<tr>
<td>LAS-1000 (2.5MB)</td>
<td>64MB</td>
</tr>
<tr>
<td>FLA-5000 (562MB)</td>
<td>768MB</td>
</tr>
</tbody>
</table>

* Peripheral devices:
  Monitor: DELL's D1025HT
  17" Trinitron monitor, with connection cables; supplied together with the computer main unit shown above.
  SCSI board: Adaptec's AHA-2930LP
  Windows® 95 driver software is supplied. The OS bundle is used.
  LBP: LBP-3500 (Canon)
2. Standard Software Configuration
   Operating system:
   - Japanese and English Windows® 98 SE
   - Japanese and English Windows® 2000
   - Japanese and English Windows® NT4.0 / Service Pack 5
   * Pre-installed system is used.

   File system:
   - Windows 98: FAT32
   - Windows 2000: NTFS
   - Windows NT: NTFS

   Analyzing software:
   Full set of Science Lab (Image Gauge + L Process)

3. High-Quality Image Output Options
   PG3000 (48MB), PG3500, PG4000 (120MB), PSD400:
   * Possible to connect one Pictrography only.

This manual has been prepared provided that users have ever operated the computer in Windows® 98, 2000 and/or Windows® NT4.0 environment and have a fair knowledge of the basic operation and displays.
2. Installing/Uninstalling the Image Gauge

2.1 Installing the Image Gauge

1. Insert the CD-ROM labeled Science Lab into the CD-ROM drive.

2. Double-click the Science Lab folder in the CD-ROM to open it.

3. Double-click the Setup.exe icon.

* The setup.exe icon can also be set up using Add / Remove programs on the control panel.
When installing the Science Lab for the first time, proceed to 4. For a computer in which the Science Lab of the previous version has already been installed, a dialog shown below will appear.

The new software cannot coexist with the previous-version software in the same machine.

If [Yes] is selected, the previous-version software will be uninstalled and the confirmation dialog shown below will appear. Select [Yes] for uninstalling the previous-version software.
4 Carefully read the messages, warnings, etc., in the Welcome dialog that follows and then click the Next button to proceed to the Software License Agreement dialog.

5 Carefully read the contents of the Software License Agreement dialog that follows. If you agree to the conditions of the agreement, click the Yes button to proceed to the Information dialog.
6 After checking the following information, click the button to go to the Customer Information dialog box.

7 Type your name and company in the Customer Information dialog box, and then click the button. After confirming the entries in the Registration Confirmation dialog box, click the button to proceed to the Choose Destination Location dialog box.

8 Check the destination folder (where the software is installed) that appears in the Choose Destination Location dialog box. If you prefer, click the button to move to Step 11, the Select Program Folder dialog box. If you want to change the folder, click the button to go to the Choose Folder dialog box.
9 Specify the destination where the [Science Lab] software should be installed and then click the **OK** button to return to the Choose Destination Location dialog.

10 Click the **Next >** button in the Choose Destination Location dialog that follows to proceed to the Select Program Folder dialog.
11 In the Select Program Folder dialog box, type the name of a program folder for registering the start-up menu or select one from the box below, and then click the button to proceed to the Start Copying Files dialog box. * The default folder name is Science Lab. If you accept this, click the button to go to the Start Copying Files dialog box.

12 Confirm the content in the following Start Copying Files dialog and then click the button. (Installation will begin.)
13 After the installation has been completed, the following dialog box appears. If you want to see the README file or to start Image Gauge soon, select the respective check boxes. Click the **Finish** button to finish the installation.
2.2 Uninstalling the Image Gauge

1. Open the Control Panel and double-click the "Add/Remove Programs" icon.

2. Select [Science Lab] in the dialog that follows and then click the "Add/Remove" button.
3. When the following confirmation dialog appears, click [Yes] if you wish to uninstall the software. (Uninstallation will then begin.)

![Confirm File Deletion]

Are you sure you want to completely remove 'Science Lab' and all of its components?

[Yes] [No]

4. The following dialog will appear to proceed with uninstallation. When all procedures have been completed, the [OK] button will be activated. Click the [OK] button to complete uninstallation.

![Remove Program from Your Computer]

uninstalled will remove the software 'Science Lab' from your computer. Please wait while each of the following components is removed...

✓ Shared program files...
✓ Shared program files...
✓ Folder items...
   Program folders...
   Program directories...
   Program registry entries...

![Remove Program from Your Computer]

uninstalled will remove the software 'Science Lab' from your computer. Please wait while each of the following components is removed...

✓ Shared program files...
✓ Standard program files...
✓ Folder items...
✓ Program folders...
✓ Program directories...
✓ Program registry entries...

Uninstallation successfully completed.

[OK]
Part B

Viewing an Image
1. Starting Up and Quitting this Software

Starting Up

1. Double-click the icon.

A few seconds after the opening dialog appears, the application will start up.
1. Starting Up and Quitting this Software

Quitting

1. Select Exit from the File menu.

   ![Exit menu]

When Image Gauge file format has been specified, the quitting procedure will continue as follows.

2. The following dialog will be displayed asking whether or not you want to save the image data analyzed using Image Gauge.

   ![Save this file before closing? dialog]

3. To save the analyzed data (quantification area data, measurement results, etc.), click YES.
   Click NO if you don’t want to save the quantification results.

Note: Analysis data will be added to the Image Gauge image file. File size will increase or decrease according to the volume of the data. Therefore, always pay attention to the data storage capacity of the media.
2. Image Gauge Menu Lists

The following six main menus are displayed on the Image Gauge menu line.

```
File    Edit    Image  Analysis  Windows  Help
```

Simple explanations of the command groups (pulldown menus) for each main menu follow.
Only the commands unique to Image Gauge, and not those for the Windows® system in general, will be explained.

Note: The Ctrl key and letter displayed to the right of each command are shortcut keys. Holding down the control key on the keyboard and press the appropriate letter will produce the same result as making a selection from the pulldown menu.

File menu

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>File</td>
<td></td>
</tr>
<tr>
<td>Open...</td>
<td>Opens an image file</td>
</tr>
<tr>
<td>Trim Again...</td>
<td>Opens an image file after trimming it</td>
</tr>
<tr>
<td>Close</td>
<td>Closes the window</td>
</tr>
<tr>
<td>Save...</td>
<td>Opens the original image file</td>
</tr>
<tr>
<td>Save as...</td>
<td>Shows file information</td>
</tr>
<tr>
<td>Reset...</td>
<td></td>
</tr>
<tr>
<td>File Info...</td>
<td></td>
</tr>
<tr>
<td>Preferences</td>
<td></td>
</tr>
<tr>
<td>Import File</td>
<td>Sets display observing conditions</td>
</tr>
<tr>
<td>Export File</td>
<td>Changes the unit of distance</td>
</tr>
<tr>
<td>Page Setup...</td>
<td>Changes the unit of quantification</td>
</tr>
<tr>
<td>Print...</td>
<td>Prints to laser beam printer</td>
</tr>
<tr>
<td>Print Pictro...</td>
<td>Prints to Pictrography</td>
</tr>
<tr>
<td>Exit</td>
<td></td>
</tr>
</tbody>
</table>

* TIFF files that can be imported are Index Color TIFF, RGB Full Color TIFF and 16bit / 8bit gray TIFF.
Edit menu

<table>
<thead>
<tr>
<th>Edit</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Undo</td>
<td>Ctrl+Z</td>
</tr>
<tr>
<td>Cut</td>
<td>Ctrl+X</td>
</tr>
<tr>
<td>Copy</td>
<td>Ctrl+C</td>
</tr>
<tr>
<td>Paste</td>
<td>Ctrl+V</td>
</tr>
<tr>
<td>Clear</td>
<td>Ctrl+D</td>
</tr>
<tr>
<td>Duplicate</td>
<td>Ctrl+D</td>
</tr>
<tr>
<td>Delete Lane...</td>
<td></td>
</tr>
<tr>
<td>Select All</td>
<td>Ctrl+A</td>
</tr>
<tr>
<td>Clear Selection</td>
<td>Ctrl+D</td>
</tr>
<tr>
<td>Group</td>
<td>Ctrl+G</td>
</tr>
<tr>
<td>Ungroup</td>
<td>Ctrl+U</td>
</tr>
</tbody>
</table>

Makes a duplicate
Deletes Lane
Forms measured results into a group
Undo Group

Image menu

<table>
<thead>
<tr>
<th>Image</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Color Type</td>
<td></td>
</tr>
<tr>
<td>Brightness/Contrast</td>
<td></td>
</tr>
<tr>
<td>Range Scope...</td>
<td>Ctrl+K</td>
</tr>
<tr>
<td>Change Color...</td>
<td>Ctrl+L</td>
</tr>
<tr>
<td>Clip Image...</td>
<td>Ctrl+J</td>
</tr>
<tr>
<td>Standard Mag...</td>
<td>Ctrl++</td>
</tr>
</tbody>
</table>

--- (1)
Enhances contrast by compressing the range
Changes the order of colors on the color bar
Pastes image on the Clipboard
Returns to the default magnification

--- (2)
Monitor display will be negative gray
Monitor display will be positive gray
Monitor display will be in 16 pseudo-colors
Monitor display will be in 32 pseudo-colors
Monitor display will be in a green fluorescent color
Monitor display will be in a red fluorescent color
Monitor display will be in a blue fluorescent color

(1) Adjusts contrast via linear tone curve
(2) Adjusts contrast via S tone curve
Adjusts contrast via curved tone curve
Adjusts contrast via period tone curve
Adjusts contrast via free-hand tone curve
Analysis menu

The items in the Analysis menu will differ depending on the window that is active at the time.

When Image Window is active

- **Renumber** (Ctrl+R): Renumbers data in order
- **Sort** (Ctrl+H): Sorts measurement Nos.
- **Calibration**
  - **Lane Standard**: Sets lane to the standard molecular measurement lane
  - **Peak Search** (Ctrl+T): Automatically searches for peak
- **Option**
  - **New...** (1): Creates new calibration curve
  - **Show...** (2): Displays current calibration curve
  - **Set...** (3): Sets the number of pixels for Auto Trace
  - **Reset**: Sets lane width
- **Quant Trace**
  - **Lane Width...**
  - **Peak Aid...**
  - **Peak Type...**
- **Renumbers data in order**
- **Displays detailed on measured numbers**

When Result Window is active

- **Renumber** (Ctrl+R): Renumbers data in order
- **Sort** (Ctrl+H): Sorts measurement Nos.
- **Calibration**
  - **Data Info** (Ctrl+F): Displays detailed on measured numbers
  - **Background**
  - **Ratio Standard**
  - **Distance Calibration...**
- **Option**
  - **New...** (4): Creates new calibration curve
  - **Show...** (5): Displays current calibration curve
  - **None Local Global** (6): Sets the display for targeted values and numbers
- **Renumbers data in order**
- **Displays detailed on measured numbers**

When Profile Window is active

- **Renumber** (Ctrl+R): Renumbers data in order
- **Data Info** (Ctrl+F): Displays details for measurement Nos.
- **Peak Search** (Ctrl+T): Searches for peak
- **Copy BG Line...**
- **Clear BG Line...**
- **Copy RF Ratio...**
- **Option**
  - **Display...** (7): Sets profile display
  - **Auto BG**
  - **Peak Type...**

Sets items to be displayed

Sets parameters for automatic recognition of profile backgrounds

Sets parameters for automatic recognition of lanes
2. Image Gauge Menu Lists

Windows menu

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Shortcut</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Image</td>
<td>Ctrl+1</td>
<td>Displays image</td>
</tr>
<tr>
<td>View</td>
<td>Ctrl+2</td>
<td>Displays whole image</td>
</tr>
<tr>
<td>Profile</td>
<td>Ctrl+3</td>
<td>Displays profile</td>
</tr>
<tr>
<td>Info</td>
<td>Ctrl+4</td>
<td>Displays Info window</td>
</tr>
<tr>
<td>Quant Result</td>
<td>Ctrl+5</td>
<td>Displays Quant mode measurement results</td>
</tr>
<tr>
<td>Profile/MW Result</td>
<td>Ctrl+6</td>
<td>Displays Profile/MW mode measurement results</td>
</tr>
<tr>
<td>Distance Result</td>
<td>Ctrl+7</td>
<td>Displays Distance mode measurement results</td>
</tr>
</tbody>
</table>

Help menu

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>About Image Gauge...</td>
<td>Displays the software name and the version.</td>
</tr>
</tbody>
</table>
3. Viewing an Image

3.1 Image Reading

See the separated "Image Reader Operation Manual."

3.2 Opening an Image File

1. Select Open... from the File menu to display the image file dialog.

   ![File Menu]

   **Open...**

<table>
<thead>
<tr>
<th>File</th>
<th>Ctrl+O</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open...</td>
<td></td>
</tr>
<tr>
<td>Open Again..</td>
<td></td>
</tr>
<tr>
<td>Close...</td>
<td></td>
</tr>
<tr>
<td>Save...</td>
<td>Ctrl+S</td>
</tr>
<tr>
<td>Save as...</td>
<td></td>
</tr>
<tr>
<td>Recent...</td>
<td></td>
</tr>
<tr>
<td>File Info...</td>
<td>Ctrl+H</td>
</tr>
<tr>
<td>Preferences</td>
<td></td>
</tr>
<tr>
<td>Import File</td>
<td></td>
</tr>
<tr>
<td>Export File</td>
<td></td>
</tr>
<tr>
<td>Page Setup...</td>
<td>Ctrl+F</td>
</tr>
<tr>
<td>Print...</td>
<td></td>
</tr>
<tr>
<td>Print dia...</td>
<td></td>
</tr>
<tr>
<td>Exit</td>
<td>Ctrl+Q</td>
</tr>
</tbody>
</table>

Note: With Image Gauge, only one image file can be opened at one time. If some image file has been altered, the following dialog will be displayed. Select YES or NO.
2 Double-click the file name you want to open in the preview window.

![Image Reader Open dialog box]

When the desired file cannot be found in the current folder, use the drop-down menu arrow to display other folders or files.

Note: The image read by the Image Reader can be opened with the Open... command. However, in this case, the Trimming dialog will be displayed. (See next page, 3.3 Trimming an Image, for details.)
3.3 Trimming an Image

1. Select **Trim Again...** from the File menu to display the image file dialog.

2. Open the desired file.
   (If the desired file cannot be found in the current folder, use the drop-down menu arrow and display other folders or files.)

3. After a file has been selected, the following Trimming dialog will appear. Referring to the table on the following page, set the region of interest (for trimming).

---

**Trimming of T-T-std4_1miki**

![Image of Trimming dialog]

- **Trimming box**
- **Range Scope** (see p. B-22, 5.3 Enhancing Contrast with Range Scope.)
3.3 Trimming an Image

The mouse pointer will change to the shape shown on the left, allowing it to be dragged.

When the mouse pointer is brought inside the trimming box, its shape will change to +., allowing it to be dragged.

When you bring the mouse pointer back outside the trimming box (the pointer will change to a |), click the mouse. The trimming box will disappear, and settings can be redone with dragging.

4. If is clicked, a dialog shown below will appear. You can directly enter on the dialog the width / height (number of pixels) of the trimming frame (Image Size) and the scope of gradation areas in Range Scope (described herein).

5. For trimming only, when there's no need for rotated/flipped display, click OK (To display an image after rotating/flipping it, proceed to the next page.)

Note: When not enough application memory can be allotted, the OK button may not activate. In such a case, add memory or reduce the trimming area to activate the OK button and then click it.
6 To display an image after rotating/flipping it, click Rotate/Flip... in the Trimming dialog and set rotation/flipping conditions in the Rotate/Flip... dialog that will appear.

7 After completing trimming and rotation/flipping settings, click OK in the Trimming dialog.
3.4 Dividing and Saving an Image

1. To divide the image currently displayed in the Trimming dialog into several files, click **Save as...** after specifying trimming options. Only the image will be divided. ROI and other additional information will not be saved.

2. Input the file name, specify where it should be saved and click **Save**.

3. When the image file has been created, the original Trimming dialog will be displayed.
4. Names of the Parts of the Image Gauge Window
5. Changing the Monitor Display

5.1 Changing the Display Color

1. Select Color Type from the Image menu and then select the desired monitor display command from the submenu.

Color Type

<table>
<thead>
<tr>
<th>Color Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Negative Gray</td>
<td>Negative gray display (low density regions are white, high density regions are black).</td>
</tr>
<tr>
<td>Positive Gray</td>
<td>Positive gray display (low density regions are black, high density regions are white).</td>
</tr>
<tr>
<td>16 Color</td>
<td>Displays in 16 pseudo-colors.</td>
</tr>
<tr>
<td>32 Color</td>
<td>Displays in 32 pseudo-colors. (Designation of colors for high and low density regions is done with Brightness/Contrast.)</td>
</tr>
<tr>
<td>Green</td>
<td>Displays in a green fluorescent color</td>
</tr>
<tr>
<td>Red</td>
<td>Displays in a red fluorescent color</td>
</tr>
<tr>
<td>Blue</td>
<td>Displays in a blue fluorescent color</td>
</tr>
</tbody>
</table>

5.2 Adjusting Contrast

1. Select Brightness/Contrast... from the Image menu and then select the desired contrast adjustment (tone curve) command from the submenu.

Brightness/Contrast...

<table>
<thead>
<tr>
<th>Tone Curve Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Linear...</td>
<td>Adjusts contrast with a linear curve (see 3 on p. B-17).</td>
</tr>
<tr>
<td>Sigmoid...</td>
<td>Adjusts contrast with an S tone curve (see 4 on p. B-17).</td>
</tr>
<tr>
<td>Curve...</td>
<td>Adjusts contrast with a tone curve (see 5 on p. B-18).</td>
</tr>
<tr>
<td>Triangular...</td>
<td>Adjusts contrast with a period tone curve (see 6 on p. B-20).</td>
</tr>
<tr>
<td>Free Hand...</td>
<td>Adjusts contrast with a free-hand tone curve (see 7 on p. B-21).</td>
</tr>
</tbody>
</table>
2. A Change Curve Dialog like the one below will be displayed. (When monitor display will be in color, you can use Color: 16 to select 16 or 32 colors for black and white in low density regions.)

- Density distribution on an image is displayed.
- Save... Saves the set 4 kinds of tone curves as a file.
- Load... Calls up the tone curves saved as a file. When this file is called up on another image, these tone curves can be applied to it.

To change the contrast adjustment command, make selections from the pulldown menu for Kind: Linear.
3 Linear
3-1 Drag the adjuster (↔) inside the gradation bar until contrast is appropriate. Image contrast will change in realtime in keeping with the dragging.

Another method for adjusting image contrast is to drag each dial on Bright: and Cont: with the mouse.

3-2 After contrast has been adjusted, click OK.

4 Sigmoid
4-1 Drag Cont: dial to adjust S tone.
4-2 By dragging the adjusters on the left and right, you can change the contrast band.

5 Curve

5-1 Change the tone curve by dragging the mouse.
5-2 By dragging the curve adjusters on the left and right, you can change the contrast band.

When the tone curve is dragged with the Alt key pressed, it will change to a Sigmoid curve.

5-3 After adjusting the contrast, click **OK**.
6 Triangular

6-1 You can move the periodic-change gradation bar by dragging it.

6-2 When you drag the Bright: dials ( ) with the mouse, you can adjust the period.

6-3 After adjusting the contrast, click .
7 Free Hand
7-1 By dragging the mouse in Free Hand, you can make a free-hand line (tone curve).

7-2 After adjusting the contrast, click [OK].

Import Function
When Import... is clicked with Free Hand selected, tone curve data will be read from the TEXT file and setting will be possible using the values that have been input.
Example of file contents: The range of values input correspond to image contrast.
5.3 Enhancing Contrast

Range Scope is a function for enhancing the contrast of a portion that has been arbitrarily selected for display from the image file. With an 8-bit image, there will be almost no change, but for an image with contrast exceeding 8 bits, the contrast level will be concentrated in a narrow range; it is possible to achieve clearer display by using Range Scope function on this portion (of narrow range) to compress it.

Note: Range Scope function only changes the display and does not at all influence the quantitative accuracy.

1. Select Range Scope... from the Image menu.

2. Drag the View Scope frame displayed on the image and move it to the region of interest. (The inside of the box will be displayed in the lower right View Scope magnified so that one pixel of the image will correspond to one pixel of the displayed image.)
3 Drag the adjuster in the Range Scope box and arbitrarily set the contrast level.

4 Otherwise, click Edit Values and enter values directly on the dialog displayed.
5.3 Enhancing Contrast

5. Click [OK]. (The image will then be redisplayed at the set contrast level.)

* Contrast adjustment in the top and bottom figures is the same.
5.4 Displaying an Entire Image

Even when enlargement has been done or the window size modified, it is always possible to display the entire image and determine the region of analysis. Image area can also be scrolled.

1. Select View from the Window menu.

   ![Windows Menu](image)
   - **Image**: Ctrl+1
   - **View**: Ctrl+2
   - **Profile**: Ctrl+3
   - **Info**: Ctrl+4
   - **Quant Result**: Ctrl+5
   - **Profile/MW Result**: Ctrl+6
   - **Distance Result**: Ctrl+7

2. The View window for the entire image will be displayed.

   ![View Window](image)

   **Green frame:** Image area developed in memory. To move, drag while holding the Alt key down.

   **Red frame:** Position displayed on current image area. Can be scrolled in realtime within the green frame.
5.5 Displaying Informations Related to Image

Image size and pixel intensity can be displayed.

1. Select Info from the Windows menu.

2. The Info bar will be displayed beneath the Menu bar.
6. Various Read Images
6. Various Read Images
6. Various Read Images
Part C

Quantifying an Image
1. Four Analysis Modes

Image Gauge has four analysis modes: Annotation, Quant, Profile, and Distance. Analysis tools have been grouped and stored according to each analysis mode. (However, some analysis tools are used in common by each mode.)

Switch between modes by using the pulldown menu from the Mode selector.

Note: Annotation mode will be in effect immediately after an image has been opened.

An overview of the four modes is presented below.

<table>
<thead>
<tr>
<th>Mode</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Annotation</td>
<td>Used for DTP operations, such as writing text or arrows onto the displayed image or bringing in other figures.</td>
</tr>
<tr>
<td>Quant</td>
<td>Measures the radioactivity within a specified region. The mouse is used to enclose (define) the region for measurement, and the radiation dose within that region is displayed in terms of units of photostimulated luminescence (PSL) in the standard. (If an arbitrary unit has been set, it is also possible to display results in terms of it.) This mode can be used to apply background subtraction, setting of standard values, and group formation, etc., to quantified results.</td>
</tr>
<tr>
<td>Profile/MW</td>
<td>Measures the PSL value for the designated region and displays a related profile graph. Quantified measurement and background subtraction can also be done on the profile graph obtained. Also, molecular weight can be measured.</td>
</tr>
<tr>
<td>Distance</td>
<td>Measures distance and angles.</td>
</tr>
</tbody>
</table>
2. Using the Analysis Tools

2.1 Analysis Tools Common to Each Mode

Explained here are the analysis tools stored within and used in common by all four modes.

**Pointer Tool**

The objects made with the tool box in each mode can be selected (activated).

(It is possible to select more than one object at one time.)

In the example shown below, operations for selecting objects made with the Oval tool in Quant mode are shown.

1. Select the Pointer tool ( ) from the tool box.

2. The 3 objects below, which were created with the Oval tool, will be used in this example. (As these objects have not yet been selected, they will be displayed in blue.)

3. To select No. 3, place the mouse pointer on it and click. (The selected object — No. 3 — will change to red.)

Note: By dragging the handles that appear with the selected object, it is possible to adjust the object.
4 To choose multiple objects, drag the region so that it includes all of the desired objects, which will allow all of them to be selected at once.

Note: When multiple objects are selected (displayed in red), it is possible to delete them (with the delete key), move them (by dragging), and conduct other operations on them all at once.

To immediately adjust an object after creating it with the other tools for each mode, you can press the Tab key to select the Pointer tool. To recreate objects, press the Tab key once more and return to the original tool.
Density Picker Tool

It is possible to display the coordinates of any position (pixel) on the image, its QL value, and its PSL value (or value for another unit that has been set).

1. Select the Density Picker tool ( ) from the tool box.

2. When the mouse pointer is moved inside the image, it will change to . At the desired position (pixel) on the image, hold down the mouse button. The coordinates of the clicked position (pixel), the QL value, PSL value or LAU value (standard) will be displayed on the right of the tool box.

   * When the Info bar is displayed, information on the clicked position (pixel) will be displayed in the Info bar.

3. Or, by holding down the Ctrl key and clicking a point on the screen, the XY axes of the coordinates will appear on the image and the XY coordinates will appear on the right of the tool box. To move the axes, use the mouse or the arrow keys on the keyboard. (The XY coordinates will change in realtime in accordance with the movement.)

4. If the Ctrl key is held down and the screen clicked once more, the XY axes of the coordinates will disappear.
QL, PSL value and cnt/LAU value:
The QL value on the image data read with the IP Reader is the gradation-divided value of the image data read using logarithms. The PSL value is the linear value derived by performing operations on the sensitivity, latitude and contrast of the QL value at the time it was originally read. However, for the image read with the IP Reader (FDL-5000) for electron microscope, the cnt value (PSL value multiplied by 31.251 of coefficient) is displayed. For the image read with the IP/Fluorescent Reader (FLA-2000), the LAU value is displayed as a unit that corresponds to the PSL value. This way, even if the reading conditions for images differ, as long as their energy levels are the same, a uniform PSL value will be expressed. When a unit system other than PSL has been set, operations will be performed based on the QL value.

With the import function, the QL value will be displayed even for opened image data. This value will depend on the hardware or software used to create the image data.
Magnifying Glass Tool

This tool is used to enlarge or reduce a displayed image.

1. Select the Magnifying Glass tool (🔍) from the tool box.

2. When the cursor is placed inside the image, it will change to 🔍.

3. When the mouse is clicked on the image, the image will be enlarged with the point clicked serving as the center. (With each click, magnification will increase, 2, 4, and 8 times.)
4 To return an enlarged image to its original state, hold the shift key on the keyboard down and click. With each click, the image will be reduced. (When the shift key is pressed, the cursor will change to \( \text{\textcopyright} \). By double-clicking the tool box, you can restore the enlargement ratio to its original status.
2.1 Analysis Tools Common to Each Mode

Hand Tool

This tool is used to scroll an image.

1. Select the Hand tool ( ) from the tool box.

2. Place the cursor inside the image and drag the mouse. (This will cause the portions of the image not displayed to appear on the screen.)

3. Another method for changing the display position is to use the mouse on the scroll bar (right or bottom edges).

By double-clicking the on the tool box, you can restore the scroll to its initial status.

In each mode, even if a different tool has been selected, pressing the Alt key on the keyboard will allow the hand tool to appear in selected status.
2.2 Annotation Mode

Image Selector tool

The Image Selector tool is used for clipping an image out and for cut and save functions.

1. Select the Image Selector tool ( ) from the tool box in Annotation mode.

2. When the cursor is placed inside the image, it will change to . Drag it to select what you want to clip out.
3 Select Clip Image... from the Image menu.

4 When the Image Resize dialog is displayed, select the desired magnification ratio and click OK.
5 The clipped image will be displayed on the screen. Even if the original image is modified, the necessary image (before modifying) can be left displayed.

6 By clicking the on the tool box while holding down the Alt key, you can display the Enter Rect Coordinate dialog. Input values within it to set the size of the rectangle as desired.

You can select the entire image by double-clicking the on the tool box.
Text Tool

This tool is used to overlay text on an image.

1. Select the Text tool (A) from the tool box in Annotation mode.

2. When the cursor is placed inside the image, it will change to 🖼️. Place the cursor 🖼️ at the point you want to overlay text and click. (The Text & Font dialog will appear.)

3. Input to the dialog box the text you want to display and use the pulldown menu to make selections for display direction, font, style, character size, and display color.

   Use ☑️Draw Vertical when you want to write text vertically.

   Note: Japanese text cannot be written vertically.
4 If you end by clicking OK, the text will appear on the image under the set conditions.

5 If you double-click the created text with the Pointer tool, the Text & Font dialog will reappear, making it possible to redo settings.
This tool is used to overlay arrows on an image.

1. Select the Arrow tool ( ) from the tool box in Annotation mode.

2. When the cursor is placed inside the image, it will change to . Drag from the place on the image where you want to start the arrow to the place where you want to end it and an arrow will be written there. (The ending point is where the head of the arrow will be.)

3. If you double-click the Arrow tool, an Arrow dialog like the following will appear. In this dialog, you can modify the settings for arrows.

If you double-click the on the tool box, the Arrow dialog will appear, allowing you to prepare settings in advance.
Info Stamp Tool

This tool is used to display the file name and other parameters for an image.

1. Select the Info Stamp tool ( ) from the tool box in Annotation mode.

2. When the cursor is placed inside the image, it will change to .
   Click and an Information Stamp dialog like the following will appear.

3. Each item within the dialog can be selected by clicking. (A check mark will appear to the right of items that have been selected.)
   To undo a selection, click the check mark for it.
   (The check mark will disappear and the selection will be undone.)
   Only the items selected in this dialog will be displayed on the image.
4 After selecting the items you want to display, click OK. The selected items will be displayed on the image.

5 If you double-click the Info Stamp you have created with the Pointer tool, you can reset the information.

If you double-click the on the tool box, the Stamp Setup dialog will appear, allowing you to prepare font and other settings in advance.
Scale Bar Tool

This tool is used for displaying the scale bar on the image.

1. Select the Scale Bar tool ( ) from the tool box in Annotation mode.

2. When the cursor is placed inside the image, it will change to . If you click it on the image, a Scale Bar dialog like the following will be displayed.

   - **Bar Length**: [Input Field]
   - **Unit**: [mm, cm, m, nm, pixel]
   - **Option Edge Lines**: [Checkbox]
     - For selecting whether or not to have vertical lines on the edges of the scroll bar.
   - **Font Size**: [12]
   - **Line Width**: [1]
   - **Color**: [Black]
   - **Line Back**: [None]
   - **Position**: [Center]

3. Select the length of the scale (bar), the unit, edges (or not), etc., and then click OK. A scale bar will then be displayed on the image.

4. If you double-click the scale bar you have created using the Pointer tool, you can redo the settings for it.
BMP Stamp Tool

This tool is used to bring a Bit Map file into an image.

1. Select the BMP Stamp tool ( ) from the tool box in Annotation mode.

2. When the cursor is placed inside the image, it will change to BMP. Click and a selection dialog like the following will be displayed. From it, select the Bit Map file that you want to bring in and click Open.

3. An Image Resize % dialog like the following will appear. After you set the size of the image you want to bring in and click, the Bit Map file will be brought onto the image.
In the above example, Profile has been brought in over the image and displayed.

4 Using the Pointer tool, double-click the Bit Map file that has been brought in to reposition it if desired.
It is possible to put a desired comment on an Info Stamp.

1. Select File Info... from the File menu.

2. The File Information dialog will appear. Click the Comment input section on the list.

3. Input the desired characters in the input box and click Change.
4 After OK is clicked, by checking the Information Stamp dialog for the Info Stamp tool, you can display the input comment.

Note: By the Delimiter Option, it will be possible to create the information file that can be used with Sun and MS-DOS.
2.3 Quant Mode

Rectangle Tool

This tool is used to enclose a desired region with a rectangle.

1. Select the Rectangle tool ( ) from the tool box in Quant mode.

2. Place the cursor on the edge of the desired region and drag it to enclose the region.
(To enclose it with a square, drag while holding the shift key down.)

3. When the region has been appropriately enclosed, release the button on the mouse. (At this time, the area will be selected automatically and displayed in red.)

Note: By dragging the four grow handles (which are red) with the Pointer tool, you can freely modify the size.
2.3 Quant Mode

Freehand Tool

This tool is used to enclose the desired region in a freehand curve.

1. Select the Freehand tool ( ) from the tool box in Quant mode.

2. Place the cursor at one end of the desired region and hold down the mouse button (do not release it).

3. When the mouse is dragged with the button held down, a freehand curve will be drawn. Drag the mouse to enclose the desired region.
4 When you release the mouse button at the end point, it will be connected directly to the starting point.
   (At this time, the area will be selected automatically and displayed in red.)

Notes:
1 By dragging the grow handle (red) with the Pointer tool, you can freely change the size.
2 If you double-click the tool box, the Trace Resolution dialog will appear. By selecting the desired number of pixels, you can set the number of pixels between points.
This tool is used to enclose the desired region in a polygon.

1. Select the Polygon tool (Polygon Tool) from the tool box in Quant mode.

2. Place the cursor at one end of the desired region and click to define the starting point of the polygon that will enclose the region.

3. When the mouse is moved with the mouse button released, a corresponding straight line will be drawn from the starting point.
4 Click the place on the polygon at which you want to end the line segment. (This will be a fixed point.)

5 When the mouse is moved with the mouse button still released, a straight line will be drawn from the point just fixed.

6 Repeat the preceding step as many times as necessary and enclose the shape of the desired region.

7 When you double-click the last point, a straight line will connect it to the starting point. (At this time, the area will be selected automatically and displayed in red.)

Note: By dragging the grow handles (red) with the Pointer tool, you can freely modify the size.
This tool is used to enclose the desired region in an oval.

1. Select the Oval tool ( ) from the tool box in Quant mode.

2. Place the cursor at the edge of the desired region and drag to enclose it.
   (To enclose the region in a circle, hold down the shift key and drag.)

3. When the region has been enclosed, release the button on the mouse. (At this time, the area will be selected automatically and displayed in red.)

Note: By dragging the grow handles (which are red) with the Pointer tool, you can freely modify the size.
Slanted Rectangle Tool

This tool is used to enclose the desired region in a slanted rectangle.

1. Select the Slanted Rectangle tool ( ) from the tool box in Quant mode.

2. Place the cursor at the edge of the desired region, drag it briefly in the direction you want to measure, and release the button on the mouse. At this time, the direction will be determined by these 2 points (the first one set and the second one dragged to).

3. When the desired region has been enclosed, click the mouse. (At this time, the area will be selected automatically and displayed in red.)

Note: By dragging the rotation handle (green) and the grow handle (red) with the Pointer tool, you can freely modify the size.
This tool is used to enclose the desired region within a ladder.

1. Select the Ladder tool ( ) from the tool box in Quant mode.

2. Place the cursor at the edge of the desired region, drag it briefly in the direction you want to measure, and release the button on the mouse. At this time, the direction will be determined by these 2 points (the first one set and the second one dragged to).
3 When the desired region has been enclosed, click the mouse.

4 By moving the mouse to the first position marked and clicking it, you can set a dividing line (which will move along with the mouse). Click the points at which you want to add dividing lines. End with a double-click. (At this time, the area will be selected automatically and displayed in red.)
Note: With grow handle (red) and rotation handle (green), you can freely change size and angles. By dragging the slide handles (blue), it is possible to change the position of the dividing lines.

If you undo the selection, the display will change to something like the following.
Matrix Tool

This tool is used to enclose the desired region in a matrix.

1. Select the Matrix tool from the tool box in Quant mode.

2. Place the cursor at the edge of the desired region, drag it briefly in the direction you want to measure, and release the button on the mouse. At this time, the direction will be determined by these 2 points (the first one set and the second one dragged to).
3. When the desired region has been enclosed, click the mouse.

4. The Matrix Dimension dialog will be displayed, so in the input column in the dialog, input the desired matrix size from the keyboard. (The smallest matrix cell will be 2mm.)
5 Click OK to display the matrix box to be used for quantification. (At this time, the area will be selected automatically and displayed in red.)

Note: By dragging the rotation handle (green) and grow handle (red) with the Pointer tool, you can freely modify the size and angles.

When the selection is undone, the display will change to something like the following.
2.3 Quant Mode

Free-Division Matrix Tool

This tool is used to enclose the desired region within a matrix with freely set divisions.

1. Select the Free-Division Matrix tool ( ) from the tool box in Quant mode.

2. Place the cursor at the edge of the desired region, drag it briefly in the direction you want to measure, and release the button on the mouse. At this time, the direction will be determined by these 2 points (the first one set and the second one dragged to).

3. When the desired region has been enclosed, click the mouse.
4 When the cursor is placed inside the enclosed area, a slice line will be displayed in first direction. (This direction will be the direction in which dragging was done from the first point.) Click in order the points at which you want to make slices and double-click the last point.

5 A slice line will appear in a second direction. As you did before, click in order the points at which you want to make slices.
6. When you double-click the last point, you will have created a matrix that has been freely divided.

Note: By dragging the rotation handle (green) and grow handle (red) with the Pointer tool, you can freely change size and angles. Using the slide handle (blue), you can change the position of the slice lines.

When the selection has been undone, the display will change to something like the following.
Automatic Band Tool

Automatically recognizes the bands within the specified lane.

1. Select the Auto Band Tool from the tool box in Quant mode.

2. Place the crosshair at the starting point of the desired region and drag the mouse in the direction that the lanes will unfold, to the end of the lanes. Release your finger from the mouse button. At this time, the direction will be determined by these two points -- the first point and the point at which you released the mouse button after dragging the mouse.
3 With your finger still off the mouse button, move the mouse. When you have enclosed the entire region of the lanes you want recognized, click the mouse. At this time, if you have enclosed too large an area, you will not be able to have the lanes correctly recognized.

Note: Up until you click the mouse button and define the region, you will be able to freely modify the size of the specified frame by using the point from which you began dragging as a fixed point.
4 The Quant Auto Lane & Band dialog will be displayed. Input the number of lanes in the input box in the dialog.

Assign Lanes Evenly: Lanes of the same width are placed within a rectangle with the same amount of space between them. The lanes on both edges are positioned to touch the rectangle.

Find Lanes: Creates lanes by recognizing lane widths, numbers, and positions from the image.

Same Lane Width: Makes lane width even.

Lane Count: Input when the number of lanes has been set ahead of time.

Band Parameter: The larger the number that is input, the more the degree of band separation is improved.
5 Click **OK**. The lanes and bands in the specified region will be automatically recognized.
Correcting a Ladder/Freehand Matrix

Corrects existing ladders and freehand matrixes, and automatic band recognition.

When the Slide Handle has been specified with the Pointer and the key is pressed, the Pointer will change to . If you drag the mouse in this condition, the slide will be copied. If you press the shift key, the Pointer will change to . If you click the mouse in this condition, the slide will be deleted.
2.3 Quant Mode

Titer Plate Tool

This tool is mainly used to specify fluorescent image areas using the titer plate.

1. Select the Titer Plate Tool from the tool box in Quant mode.

* When the Titer Plate Tool has been specified and clicked on the image, the plate used the last will be displayed. (The default in this software is 96 holes).

2. The Dots Properties dialog as shown below will appear. Specify plate conditions.

![Dots Properties Dialog](image)

Format:
- **Horizontal**: Enter the number of horizontal wells.
- **Vertical**: Enter the number of vertical wells.
- **Direction**: Select how to display the index.
- **Diameter**: Enter diameter of the well in unit of mm.
- **Pitch**: Enter the distance between horizontal wells and also that between horizontal and vertical wells in unit of m.

Format:
- **Horizontal**: Enter the number of horizontal wells.
- **Vertical**: Enter the number of vertical wells.
- **Direction**: Select how to display the index.
- **Diameter**: Enter diameter of the well in unit of mm.
- **Pitch**: Enter the distance between horizontal wells and also that between horizontal and vertical wells in unit of m.
3 Click **OK** and then click the cursor on the image. The selected plate will be displayed.

4 The plate position can be adjusted by mouse dragging and the angle by dragging the rotation handle.

5 The diameter of the well and the distance between horizontal wells and that between horizontal and vertical wells can be re-set in the Dots Properties dialog that appears by double-clicking the plate on the image.
Magic Wands Tool

This tool is used to semi-automatically enclose the desired region.

1. Select the Magic Wands tool ( ) from the tool box in Quant mode.

2. When the cursor is placed inside the image, it will change to .
   Place the cursor on the region you want to enclose (without letting go of the mouse).
   At this point, the region can be drawn automatically. Drag to enclose the region in the best way and then release the mouse.
3 At this time, the area will be automatically selected and outlined in red. If you want to make fine adjustments, select the Pointer tool from the tool box and then drag the grow handle.

Note: If you double-click the on the tool box, the Trace Resolution dialog will appear. By selecting the desired number of pixels, you can set the number of pixels between points.
Free Edit Tool

This tool is used to modify the shape of ROI.
It is used for ROI created with the Free Hand tool and Polygon tool.

1. Select the Free Edit tool, [image], from the tool box in Quant mode.

2. When the mouse pointer is placed inside the image, it will change to [image].

2-1 Partial deletion
Drag the mouse and with the Pointer mark off 2 places on the ROI.

When the mouse is released after the places have been marked off, the Pointer will change to [image].
Place the [image] above the portion you want to remain and click to have the ROI edited.

2-1 Partial addition
The same as for a deletion, use the Pointer to mark off 2 places on the ROI.

Release the mouse after the places have been marked, place the [image] above the original ROI, and click to edit.
Menu Functions Related to Quant

Making an ROI Data File

By filing a created ROI (Region of Interest; made and enclosed with tools in Quant mode), it is possible to call it up for other images and reuse it.

1. Using the Pointer tool, select the ROI that you want to save.

2. Select ROIs / Lanes... from the Export File submenu of the File menu.
3 Set the file name and destination (folder it should be stored in) and then save it.

4 When you want to use it on a different image file, open the file in Quant mode and select ROIs / Lanes... from the Import submenu of the File menu to import it.
Using Duplicate

This function is used to duplicate single or multiple objects that have been created. On an image that has multiple lanes, as shown below, we will use as an example the procedure for quantifying each lane in the same format.

1. Quantify one lane. With the Pointer tool, activate the ROI that you want to copy.

2. Select Duplicate from the Edit menu.
3 A copy of the selected ROI will be displayed on the screen. (It will be as selected.)
Drag the duplicated ROI with the Pointer, move it to another lane, and readjust the size and position, thus making it into the desired ROI.

You can duplicate an object by activating it and then dragging it with the Ctrl key held down.
2.3 Quant Mode

Saving Quantification Areas

1. Activate (red) the quantification setting area(s) on the image.

2. Select Export File from the File menu and then ROIs/Lanes from the submenu.

3. Input the file name in the open dialog and specify the destination for saving.

4. The saved file will be displayed as the icon shown below.
Retrieving the Saved Quantification Areas

1. Select Import File from the File menu and then ROIs/Lanes from the submenu.

2. Specify the saved quantification area in the open dialog and open it.

3. The offset values can be specified in the Position dialog below.
In the saved quantification area, the position on the image when the area was saved is stored.

For example, when retrieving the quantification area stored as shown at the left on a different image B, the area will be positioned on Image B according to the image positioning conditions on Image A (at the 100 pixel/100 pixel position when viewed from the top left corner), assuming that

Left offset: 0 pixel and
Top offset: 0 pixel

in the Position dialog.

When offset values are changed to Left: 50 pixels and Top: 50 pixels on the Image B in the Position dialog, the quantification area will be shifted as shown below.

* If the quantification area is not positioned on the image after offset has been specified, it will be positioned out of the image area. Make sure to adjust the offset value so that the quantification area is within the image area.
### Displaying Quant Results

1. Select Quant Result from the Windows menu.

<table>
<thead>
<tr>
<th>Windows</th>
</tr>
</thead>
<tbody>
<tr>
<td>Image</td>
</tr>
<tr>
<td>View</td>
</tr>
<tr>
<td>Profile</td>
</tr>
<tr>
<td>Info</td>
</tr>
<tr>
<td>Quant Result</td>
</tr>
<tr>
<td>Profile/MW Result</td>
</tr>
<tr>
<td>Distance Result</td>
</tr>
</tbody>
</table>

#### Quant Result

<table>
<thead>
<tr>
<th>No.</th>
<th>Index</th>
<th>No.</th>
<th>Area Name</th>
<th>PSIL</th>
<th>Area (um²)</th>
<th>PSIL-BG</th>
<th>Ratio</th>
<th>% of Exp</th>
<th>PSIL area</th>
<th>(P-D)Area</th>
<th>Calibrated</th>
<th>Known</th>
<th>Edc</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>A-1</td>
<td>A</td>
<td></td>
<td>10146.00</td>
<td>277.52</td>
<td>10146.00</td>
<td>------</td>
<td>19.1</td>
<td>36.55</td>
<td>36.55</td>
<td>------</td>
<td>------</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>A-2</td>
<td>A</td>
<td></td>
<td>5303.00</td>
<td>277.48</td>
<td>5230.00</td>
<td>------</td>
<td>1.00</td>
<td>19.11</td>
<td>19.11</td>
<td>------</td>
<td>------</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>A-4</td>
<td>A</td>
<td>14760.00</td>
<td>280.34</td>
<td>14760.00</td>
<td>------</td>
<td>2.79</td>
<td>32.57</td>
<td>32.57</td>
<td>32.57</td>
<td>------</td>
<td>------</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>A-3</td>
<td>A</td>
<td>14300.00</td>
<td>277.52</td>
<td>14300.00</td>
<td>------</td>
<td>2.70</td>
<td>31.53</td>
<td>31.53</td>
<td>31.53</td>
<td>------</td>
<td>------</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>A-5</td>
<td>A</td>
<td>19190.00</td>
<td>280.20</td>
<td>19190.00</td>
<td>------</td>
<td>5.62</td>
<td>68.48</td>
<td>68.48</td>
<td>68.48</td>
<td>------</td>
<td>------</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>B-1</td>
<td>A</td>
<td>11526.00</td>
<td>291.60</td>
<td>11526.00</td>
<td>------</td>
<td>2.17</td>
<td>40.39</td>
<td>40.39</td>
<td>40.39</td>
<td>------</td>
<td>------</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>B-2</td>
<td>A</td>
<td>7781.00</td>
<td>281.36</td>
<td>7781.00</td>
<td>------</td>
<td>1.87</td>
<td>27.53</td>
<td>27.53</td>
<td>27.53</td>
<td>------</td>
<td>------</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>B-3</td>
<td>A</td>
<td>13010.00</td>
<td>284.36</td>
<td>13010.00</td>
<td>------</td>
<td>2.45</td>
<td>45.75</td>
<td>45.75</td>
<td>45.75</td>
<td>------</td>
<td>------</td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>B-4</td>
<td>A</td>
<td>15980.00</td>
<td>281.60</td>
<td>15980.00</td>
<td>------</td>
<td>2.85</td>
<td>53.56</td>
<td>53.56</td>
<td>53.56</td>
<td>------</td>
<td>------</td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>B-5</td>
<td>A</td>
<td>22320.00</td>
<td>284.32</td>
<td>22320.00</td>
<td>------</td>
<td>4.28</td>
<td>79.22</td>
<td>79.22</td>
<td>79.22</td>
<td>------</td>
<td>------</td>
<td></td>
</tr>
</tbody>
</table>
2.4 Profile/MW Mode

Line Profile Tool

The Line Profile tool is used to select (and display) a line segment from an image and measure its corresponding PSL profile.

1. Select the Line Profile tool ( ) from the tool box in Profile/MW mode.

2. When the cursor is placed inside the image, it will change to +. Place it on the top center of the lane and drag it over the desired region. Release the mouse button. (The line profile will be displayed in red.)

Note: Drag the lane while holding down the shift key on the keyboard to draw a vertical or horizontal lane.

Select Peak Aid... on the Option submenu from the Analysis menu to display the Peak Aid dialog. (See p. C-70, Peak Aid Function.)
2.4 Profile/MW Mode

This tool is used to connect 2 points on a lane of set width and measure the profile of the lane.

1. Select the Lane Profile tool ( ) from the tool box in Profile/MW mode.

2. When the cursor is placed inside the image, it will change to . Drag the cursor to one end of the lane and click.

By dragging the rotation handle (green) with the Pointer tool, you can change the angle.

3. Double-clicking the created lane profile with the Pointer tool makes it possible to redo the width settings.

Double-click the on the tool box to display the Profile Width dialog and set the lane width prior to drawing lanes.
Smile Lane Profile Tool

This tool is effective for setting a smiled lane.

1. Select the Smile Lane Profile tool ( ) from the tool box in Profile/MW mode.

2. When the cursor is placed inside the image, it will change to .
   Place the cursor at the top of the lane and click.
3 Next, click the point on the profile you want to bend and then click the 3rd and 4th points and bands along the lane. End by double-clicking to finish setting the region. (The outline of the Smile Lane Profile will change to red.)

Note: By dragging the rotation handle (green) with the Pointer tool, you can change the angle.

4 By double-clicking the created Smile Lane Profile with the Pointer tool, you can redo the width settings.

Quick

Double-click the on the tool box to display the Profile Width dialog, making it possible to set the lane width prior to drawing lanes.
Start Line Tool

This tool can be used to align the starting lines when drawing a Profile Line for each lane.

1. **Select the Start Line tool ( )** from the tool box in Profile/MW mode.

2. **When the cursor is placed inside the image, it will change to .** Drag the mouse on the image from one point to another to display the start line you have created.
3 To create regions for the Line Profile, Lane Profile, and/or Smile Profile, by dragging from the start line, the starting points for each profile will be automatically aligned.

Note: If the profile region is moved after it has been created, it will be released from the start line. In addition, the start line cannot be moved or adjusted.
Automatic Lane/Band Tool

Automatically recognizes lanes, bands and/or BG within a specified area.

1. Select the Auto Lane/Band tool from the tool box in Profile/MW mode.

2. Place the crosshair at the starting point of the desired region and drag the mouse in the direction that the lane will unfold, to the end of the lanes. Release your finger from the mouse button. At this time, the direction will be determined by these two points -- the first point and the point at which you released the mouse button after dragging the mouse.
3 With your finger still off the mouse button, move the mouse. When you have enclosed the entire region of the lanes you want recognized, click the mouse. At this time, if you have enclosed too large an area, you will not be able to have the lanes correctly recognized.

Note: Up until you click the mouse button and define the region, you will be able to freely modify the size of the specified frame by using the point from which you began dragging as a fixed point.

4 The Profile Auto Lane & Band dialog will be displayed. Select each item as necessary.

Assign Lanes Evenly: Lanes of the same width are placed within a rectangle with the same amount of space between them. The lanes on both edges are positioned to touch the rectangle.

Find Lanes: Creates lanes by recognizing lane widths, numbers, and positions from the image.

Same Lane Width: Makes lane width even.

Lane Count: Input when the number of lanes has been set ahead of time.

Auto Peak Search: Automatically recognizes peaks (bands) in lanes.

Peak: Automatically recognizes peaks (bands) in each lane.

Peak & GB: Automatically recognizes peaks and backgrounds in each lane.
5 Click OK. The lanes, lanes and bands, or lanes, bands and BG in the specified region will be automatically recognized.
(The following illustration is an example of automatic lane and band recognition.)
Band Tool

Specifies bands within lanes.

1. Select the Band tool, from the tool box in Profile/MW mode.

2. When the Mouse pointer is placed inside the image, it will change to (×).
   Clicking the Mouse pointer above a band will mark that band.
Menu Functions Related to Profile/MW

Deleting Lane

The lane that has been quantified cannot be deleted, even pressing the delete key or selecting the Clear from the Edit menu. The following dialog will be displayed.

In this case, select the Delete Lane... from the Edit menu if you wish to delete the lane with the quantified result.
Setting Lane Width

The lane width for Lane Profiles and Smile Lane Profiles can be set as desired.

1. Select Lane Width... from the Option submenu from the Analysis menu.

2. The following dialog will be displayed. Input Profile width in terms the number of pixels and click [OK]. (You can also open this dialog by double-clicking the tool box with the Pointer.)
Setting the Peak ROI Type

Set the Peak ROI Type when using Auto Peak.

1 Select Peak Type... from the Option submenu of the Analysis Menu.

2 The following dialog will appear. Select the ROI type.

Point Peak: Recognizes Peak in units of 1 pixel.
Integrated Peak: Abstracts Peak from a certain width.
Peak Aid Function

Peak search functions using tools from Profile/MW and Distance modes and Profile line extensions functions are provided.

1. Select Peak Aid... from the Option submenu of the Analysis menu.

![Screenshot of Option menu with Peak Aid selected]

2. The following dialog will appear. Set the necessary items.

![Screenshot of Peak Aid dialog]

- **Use Peak Aid:** When q is clicked, a check mark will appear and this function will be available for use. At this time, PK Aid On will be displayed on the side of the tool box.

- **Search Area:** With the point clicked with the mouse serving as the center, a fixed area is searched and the point on the highest peak is automatically determined. Set the number of pixels for the area of automatic search.

- **Profile Extend:** When the Profile Line is specified and the center of the peak is selected, the distribution on the outside is not known. Here, this function can be used to automatically extend the Profile Line on both sides by "n%," the value of which is input in the dialog.
Ex.: When Profile Extend is used (top) and when it's not (bottom)
Saving the Lane

1. Active (red) the lane on the image. (Multiple lanes can be selected.)

2. Select Export File from the File menu and then ROIs/Lanes... from the submenu.

3. Input the file name in the open dialog and specify the destination for saving.

4. The saved file will be displayed as the icon shown below.
Retrieving the Saved Lane

1. Select Import File from the File menu and then ROIs/Lanes from the submenu.

2. Specify the saved lane in the open dialog and open it.

3. The offset values can be specified in the Position dialog below.
In the saved lane, the position on the image when the lane was saved is stored.

For example, when retrieving the saved lane as shown at the left on a different image B, the lane will be positioned on Image B according to the image positioning conditions on Image A (at the 100 pixel/100 pixel position when viewed from the top left corner), assuming that

Left offset: 0 pixel
Top offset: 0 pixel

in the Position dialog.

When offset values are changed to Left: 50 pixels, Top: 50 pixels on the Image B in the Position dialog, the lane position will be shifted as shown below.
Displaying Profiles

1. Select Profile from the Windows menu.

   **Windows**
   
<table>
<thead>
<tr>
<th>Command</th>
<th>Shortkey</th>
</tr>
</thead>
<tbody>
<tr>
<td>Image</td>
<td>Ctrl+1</td>
</tr>
<tr>
<td>View</td>
<td>Ctrl+2</td>
</tr>
<tr>
<td>Profile</td>
<td>Ctrl+3</td>
</tr>
<tr>
<td>Info</td>
<td>Ctrl+4</td>
</tr>
<tr>
<td>Quant Result</td>
<td>Ctrl+5</td>
</tr>
<tr>
<td>Profile/MW Result</td>
<td>Ctrl+6</td>
</tr>
<tr>
<td>Distance Result</td>
<td>Ctrl+7</td>
</tr>
</tbody>
</table>

The profile selected with the Profile tool will be displayed.
2.5 Distance Mode

Distance Tool

1. Select the Distance tool from the tool box in Distance mode.

2. When the cursor is placed inside the image, it will change to . Click the point on the image at which you want to begin measurement. Next, move the mouse to the first point that you want to measure (the measurement line will be displayed) and click.

3. Then, move the mouse to the second point (the measurement line will be extended from the first point) and click. Use the same procedure for setting other points and then double-click the end point.
4. To view (display) results of measurement, select Distance Result from the Windows menu.

![Distance Mode Image]

<table>
<thead>
<tr>
<th>Dist &amp; Angle Result</th>
<th></th>
<th></th>
<th></th>
<th></th>
<th>Dist (mm)</th>
<th>Sum (mm)</th>
<th>Angle</th>
</tr>
</thead>
<tbody>
<tr>
<td>No.</td>
<td>Pnt</td>
<td>Name</td>
<td>X1</td>
<td>Y1</td>
<td>X2</td>
<td>Y2</td>
<td>X3</td>
</tr>
<tr>
<td>1</td>
<td>1</td>
<td>M Dist-1</td>
<td>287</td>
<td>202</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>2</td>
<td>209</td>
<td>429</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>3</td>
<td>301</td>
<td>448</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>4</td>
<td>302</td>
<td>474</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>5</td>
<td>304</td>
<td>513</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>6</td>
<td>307</td>
<td>528</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>7</td>
<td>309</td>
<td>600</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>8</td>
<td>310</td>
<td>623</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>9</td>
<td>310</td>
<td>640</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>10</td>
<td>317</td>
<td>723</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
2.5 Distance Mode

Interval Tool

This tool can be used to measure the distance between curves by using a parallel line that reaches between the two points you want to measure, allowing for accurate measurement of edges.

1. Select the Interval tool ( ) from the tool box in Distance mode.

2. When the mouse cursor is placed inside the image, it will change to . Click on the image the point at which you want to begin measurement. Next, move the mouse (the measurement line will be displayed) to the point at which you want to end measurement and click.
3. To view (display) the results of distance measurement, select **Distance Result** from the Windows menu.
Angle Tool

This tool can be used to measure any angle on an image.

1. Select the Angle tool (.Resolve icon) from the tool box in Distance mode.

2. When the cursor is placed inside the image, it will change to $\theta$. Click 3 points on the image to create the angle that you want to measure.
3. To view (display) results of measurement, select Distance Result from the Windows menu.

```
Windows

<table>
<thead>
<tr>
<th>Command</th>
<th>Shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td>Image</td>
<td>Ctrl+1</td>
</tr>
<tr>
<td>View</td>
<td>Ctrl+2</td>
</tr>
<tr>
<td>Profile</td>
<td>Ctrl+3</td>
</tr>
<tr>
<td>Info</td>
<td>Ctrl+4</td>
</tr>
<tr>
<td>Quant Result</td>
<td>Ctrl+5</td>
</tr>
<tr>
<td>Profile/MIW Result</td>
<td>Ctrl+6</td>
</tr>
<tr>
<td>Distance Result</td>
<td>Ctrl+7</td>
</tr>
</tbody>
</table>
```

Dist & Angle Result

<table>
<thead>
<tr>
<th>No</th>
<th>Pr</th>
<th>Name</th>
<th>X1</th>
<th>Y1</th>
<th>X2</th>
<th>Y2</th>
<th>X3</th>
<th>Y3</th>
<th>Dist (nm)</th>
<th>Sum (nm)</th>
<th>Angle</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>0</td>
<td>Angle-1</td>
<td>555</td>
<td>312</td>
<td>580</td>
<td>228</td>
<td>563</td>
<td>337</td>
<td>01.3</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Part D

Analyzing Quantification Results
1. Analysis in Quant Mode

Selection of Displayed Items

**Option - List**

1. Select Quant Result from the Window menu. Quantification results will be displayed similarly to the following.

| Index | Group | Area name | Radiation dose | Area of the measured region | Measurement number | Known value | Calibrated value | Percent of group each value represents | Value against the standard value | Value per 1mm² | Value per 1mm² with background subtraction | Percent of group each value represents | Value against the standard value | Value per 1mm² | Value per 1mm² with background subtraction |
|-------|-------|-----------|----------------|-----------------------------|--------------------|-------------|-----------------|----------------------------------|---------------------------------|---------------|-------------------------------------------|--------------------------------|--|-----------------------------|----------------------------------|---------------------------------|---------------|-------------------------------------------|
| 1     | A     |           |                |                             |                     |             |                 |                                  |                                 |               |                                           |                                  |                                 |               |                                           |
| 2     | A     |           |                |                             |                     |             |                 |                                  |                                 |               |                                           |                                  |                                 |               |                                           |
| 3     | A     |           |                |                             |                     |             |                 |                                  |                                 |               |                                           |                                  |                                 |               |                                           |
| 4     | A     |           |                |                             |                     |             |                 |                                  |                                 |               |                                           |                                  |                                 |               |                                           |

2. You can select the items you want to have displayed when measurement results are displayed. Select List on the Option submenu from the Analysis menu.
3. A Quant List Item dialog like the following will be shown. By clicking the checked boxes, you can decide whether to display the items they represent or not.

Click the Quant List box to display the Quant List Item dialog.

Quant List box
Dividing Measured Regions into Groups

Depending on the experiment method, it is possible to divide the entire region to be measured into groups of regions based on differences in factors (conditions) and display them.

1. While holding down the Ctrl key, click (and thus define) the measurement Nos. that you want to form into one group. At this time, as long as the position clicked is something other than Area Name, you can click anywhere within the line for the region.

Method 1
To select multiple consecutive measurement Nos. at one time, click the top measurement No. you want to select. Then, while holding down the shift key, click the last of the Nos. you want to select. The Nos. in between the two that were clicked will all be selected.

Method 2
Drag the mouse to anywhere except the Area Name column. The measurement Nos. for the area thus specified will be selected.
1. Analysis in Quant Mode

2. Select Group from the Edit menu.

3. The regions that have been divided into groups will be shown on the bottom lines of the Quant Result table. In the group column, the group name will be displayed (name will be a letter; "A" in the following example).

4. To undo the grouping, select the measurement No. and then select Ungroup from the Edit menu.
Procedure for assigning a new measurement No. to a group that has already been selected

1. Select the measurement No. that you wish to add and drag it with the mouse.

2. Place the cursor in the space for the measurement number of the group that you wish to add, hold down the Ctrl key and then release the mouse button. The dragged measurement No. will be added to that group.
Quant Result Operations

(1) Background Subtraction

**Background**

When the sample undergoes exposure, background noise always manages to enter. If this background noise is not eliminated (subtracted), sample data cannot be accurately measured. Thus, an ROI for measuring the background is created and that value is subtracted and displayed.

*Note*: Subtraction is done by multiplying the background around the unit area by the area of the sample data.

(1)-1 When there is no group division

1. Click the measurement No. of the background region in the Quant Result table to select it. (Here, "12" will be used as an example.)

2. Select Local from the Background submenu of the Analysis menu.

![Quant Result Table]

<table>
<thead>
<tr>
<th>No.</th>
<th>Index</th>
<th>Area Name</th>
<th>PSPL Area (mm²)</th>
<th>PSPL EG</th>
<th>Ratio (PSPL/EG)</th>
<th>% of Grp</th>
<th>PSPL/mm²</th>
<th>EG/mm²</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td></td>
<td></td>
<td>20760.00</td>
<td>330.88</td>
<td>65.95</td>
<td>1.11</td>
<td>53.24</td>
<td>53.24</td>
</tr>
<tr>
<td>2</td>
<td></td>
<td></td>
<td>323.00</td>
<td>347.00</td>
<td>91.60</td>
<td>1.22</td>
<td>84.10</td>
<td>84.10</td>
</tr>
<tr>
<td>3</td>
<td></td>
<td></td>
<td>2651.00</td>
<td>2651.00</td>
<td>100.10</td>
<td>1.14</td>
<td>100.10</td>
<td>100.10</td>
</tr>
<tr>
<td>4</td>
<td></td>
<td></td>
<td>1155.33</td>
<td>5933.00</td>
<td>3.49</td>
<td>74.12</td>
<td>74.12</td>
<td>74.12</td>
</tr>
<tr>
<td>5</td>
<td></td>
<td></td>
<td>2891.00</td>
<td>3890.60</td>
<td>52.24</td>
<td>0.91</td>
<td>52.24</td>
<td>52.24</td>
</tr>
<tr>
<td>6</td>
<td></td>
<td></td>
<td>111160.00</td>
<td>430.50</td>
<td>4.51</td>
<td>5.51</td>
<td>255.26</td>
<td>255.26</td>
</tr>
<tr>
<td>7</td>
<td></td>
<td></td>
<td>44360.00</td>
<td>2222.24</td>
<td>19.05</td>
<td>10.06</td>
<td>132.10</td>
<td>132.10</td>
</tr>
<tr>
<td>8</td>
<td></td>
<td></td>
<td>114400.00</td>
<td>4830.00</td>
<td>5.05</td>
<td>5.05</td>
<td>132.10</td>
<td>132.10</td>
</tr>
<tr>
<td>9</td>
<td></td>
<td></td>
<td>122400.00</td>
<td>1.10x10^3</td>
<td>51.65</td>
<td>112.16</td>
<td>112.16</td>
<td></td>
</tr>
<tr>
<td>10</td>
<td></td>
<td></td>
<td>454.88</td>
<td>6699.00</td>
<td>2.71</td>
<td>143.40</td>
<td>143.40</td>
<td>143.40</td>
</tr>
<tr>
<td>11</td>
<td></td>
<td></td>
<td>2666.00</td>
<td>302.70</td>
<td>0.02</td>
<td>0.02</td>
<td>6.01</td>
<td>0.01</td>
</tr>
<tr>
<td>12</td>
<td></td>
<td></td>
<td>245.10</td>
<td>41.83</td>
<td>0.01</td>
<td>0.01</td>
<td>5.52</td>
<td>5.52</td>
</tr>
</tbody>
</table>

Local For setting background within the same group only.

Global For setting background for all groups (or all the regions).
The specified background value will be subtracted from all the regions (bands) and the PSL-BG value will automatically be displayed on the Quant Result table.

In the Quant Result table, in the left half of the Info column of a row in which background was set, a [B] will be displayed to indicate that that region is a background.

Note: When no background has been specified, PSL-BG will be displayed with BG=0.

(1)-2 When there is group division

It is possible to apply to all the groups one background that does not belong to any of them. However, if a background within a group has already been set, this cannot be done. Also, the last background set within a group will take priority.

1 Click the measurement No. of the background region in the Quant Result table that you want to use for all groups to select it ("12" in this example).
1. Analysis in Quant Mode

2. Select Global on the Background submenu from the Analysis menu.

3. When Global is selected, \( B \) will be shown in the Info column.

Note: When multiple backgrounds have been set, the average value for them can be applied as a background (for both Local and Global).
4 As shown in the following example, when a background has been set within a group (here, measurement No. 13 has been set in Group A), that background will be given priority.

<table>
<thead>
<tr>
<th>No.</th>
<th>Index</th>
<th>Area Name</th>
<th>P/L</th>
<th>Area (mm²)</th>
<th>P/L = 0</th>
<th>% of G [A]</th>
<th>P/L/merg</th>
<th>(P/L-merg)</th>
<th>Ratio</th>
</tr>
</thead>
<tbody>
<tr>
<td>4</td>
<td>-----</td>
<td></td>
<td>249999</td>
<td>1150.39</td>
<td>796590</td>
<td>3.55</td>
<td>74.43</td>
<td>56.43</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>-----</td>
<td></td>
<td>249999</td>
<td>1300.93</td>
<td>796590</td>
<td>9.97</td>
<td>82.24</td>
<td>57.91</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>-----</td>
<td></td>
<td>111111</td>
<td>451.55</td>
<td>600606</td>
<td>4.84</td>
<td>55.30</td>
<td>34.39</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>-----</td>
<td></td>
<td>444444</td>
<td>2222.24</td>
<td>450700</td>
<td>19.98</td>
<td>156.10</td>
<td>176.39</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>-----</td>
<td></td>
<td>144444</td>
<td>888.48</td>
<td>765000</td>
<td>5.20</td>
<td>112.40</td>
<td>115.59</td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>-----</td>
<td></td>
<td>177777</td>
<td>1111.11</td>
<td>1200000</td>
<td>63.56</td>
<td>112.10</td>
<td>139.30</td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>-----</td>
<td></td>
<td>000000</td>
<td>454.88</td>
<td>656100</td>
<td>2.85</td>
<td>102.30</td>
<td>117.65</td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>-----</td>
<td></td>
<td>766666</td>
<td>302.70</td>
<td>260400</td>
<td>3.69</td>
<td>6.61</td>
<td>2.60</td>
<td></td>
</tr>
<tr>
<td>12</td>
<td>-----</td>
<td></td>
<td>244444</td>
<td>41.41</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>-----</td>
<td>A</td>
<td>267699</td>
<td>230.30</td>
<td>229000</td>
<td>32.51</td>
<td>99.25</td>
<td>95.45</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>-----</td>
<td>A</td>
<td>333333</td>
<td>333.33</td>
<td>282300</td>
<td>34.16</td>
<td>91.85</td>
<td>85.61</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>-----</td>
<td>A</td>
<td>261010</td>
<td>204.10</td>
<td>272400</td>
<td>32.35</td>
<td>100.30</td>
<td>95.69</td>
<td></td>
</tr>
<tr>
<td>13</td>
<td>-----</td>
<td>A</td>
<td>555555</td>
<td>126.70</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

5 To undo a background, select the measurement No. that you want to undo and then select None on the Background submenu from the Analysis menu.

(2) Setting a Standard

A sample you want to quantify and an already quantified (known) standard can be exposed on the same IP. The value for each measured region can be displayed as a ratio of the value of the measured standard.

(2)-1 Setting a Standard when there is no group division

1 From the Quant Result table, click to select the measurement No. of the standard to be used for quantification (here, measurement No. 9 has been set as a standard). (Multiple standards cannot be set.)
2. Select Ratio Standard from the Analysis menu.

The value for the specified standard will be set at 100 for each group. The value for other regions will be recalculated in kind. The revised values will automatically be displayed in the Ratio column in the Quant Result table. Also, in the right half of the Info column on the line where the standard was set, an 5 will be displayed to indicate that region is the standard.
(2)-2 Setting a Standard for Each Group

1. Divide the regions in the Quant Result table into groups. (See p. D-4, Dividing Measured Regions into Groups, Group.)

2. In the Quant Result table, for each group click to specify the standard to be used for quantification and select Standard from the Analysis Menu.

The value for each specified standard will be set at 100 for each group. The value for other regions (bands) for each group will be recalculated in kind. The revised values will automatically be displayed in the Ratio column in the Quant Result table. Also, in the right half of the Info column on the line where the standard was set, an [S] will be displayed to indicate that that region is the standard.
1. Analysis in Quant Mode

1. With one measurement No. selected, select Date Info... from the Analysis menu. The following About This Quant dialog will be displayed.

   ![Image of About This Quant dialog]

   Each item in this dialog can be set.

   - **No.** Displays the measurement No. currently selected. When regions are erased and measurement Nos. are freed up in kind, this function can be used to reassign Nos.
   - **Area Name box** For inputting the characters that will display the Area Name. (Will be displayed as the Area Name for Quant Result.)
   - **Memo** For inputting information for each measurement No. (Will not be displayed in Quant Result.)
   - **Group** For changing group assignments.
   - **Background** None, Local, or Global can be set.
   - **Standard** Check to set the standard.
1. Analysis in Quant Mode

1. Double-click the measurement No. to display the About This Quant dialog.

2-1. By double-clicking the data information (left and right sides of the Info column) for the measurement No., the Local background and standard can be set.

2-2. Click [B] while holding down the shift key to make Local and Global selections.
(4) Setting Reference Values

1. It is possible to modify the standard values for % of Grp and Ratio.
   Select Table on the Option submenu on the Analysis menu.

**Quant Options - Table**

2. Click to select each item that you want to set for the image.

Note: On the Result window, the selected Ratio will be shown in red and the selected % of Grp will be shown in green. When the same item for the image is used, that item will be shown in light blue.

(5) Setting the Calibration Curve

Create a calibration curve from the quantification results.

1. Create the ROI you will use with the calibration curve.

2. From Quant Result, click to select the data you will use for the calibration curve. To select multiple pieces of data, click the appropriate measurement Nos. while holding down the *shift* key.

3. Select New on the Calibration submenu on the Analysis menu.
4 A Density Calibration dialog like the following will be displayed. Here, you can input the known values of each quantification result and set other items.

It is possible to save as a file the known values input using Save... and to recall them using Load...

**Convert Method:**  
- Volume
- Density

**Measured:**  
- PSL
- PSL to D/5
- PSL to Area
- PSL to D/5 to Area

**Convert Function:**  
- $\log Y = \log aX + b$
- $Y = aX$
- $Y = aX^2 + bX + c$
- $Y = aX + bX^2 + cX^3 + dX^4 + e$
- $Y = aX^3 + bX^4 + cX^5 + dX^6 + eX^7$

**Scale Measured(X):**  
- Linear
- Log

**Scale Measured(Y):**  
- Linear
- Log

**Unit:**  
- Calibrated
5 Click Curve Fit to draw the curve.

6 Lastly, click Apply. The values in Quant Result will be converted based on the calibration curve created. Here, the measured values for the image will have undergone calibration.
7 Select Show on the Calibration submenu on the Analysis menu. The current calibration curve dialog will be displayed. This calibration curve cannot be updated, but saving and/or printing are possible. Click OK to close the display.
2. Analysis in Profile/MW Mode

Displaying the Profile Line

When Profile is selected from the Windows menu in Profile mode, a Profile line like the following will be displayed.

Profile mode has the following two submodes.

Display  For modifying the graph display method.
Measure  For taking measurements from the graph.

To switch between modes, use the Mode pulldown menu.
2.1 Display Mode
(Including common tools)

Sequential Switcher

When multiple profiles exist, they can be switched between in order of the profile numbers that have been assigned to them. Each time the arrows are clicked, the number of the profile for display will change.

Pulldown Switcher

1. Select the profile number from the pulldown menu on the tool box.

2. In Display mode, it is possible to display multiple profiles at one time. Select Select... from the pulldown menu.
3 The Select Profiles dialog will be displayed. Click the profiles you wish to display at one time to select them and end by clicking OK.

![Select Profiles dialog](image)

4 The selected profiles will be selected all at one time (only in Display mode).

![Profile selection](image)

Note: In step 3, above, before clicking OK, it is possible to change the display color by using the Profile Color pulldown menu from the Select Profiles dialog.

At this time, there will be only one selected profile (shown with a solid line). The others will appear as unselected (shown with a broken line). To change selection, use the Pointer tool. It is also possible to use Measure mode on a selected profile.
2.1 Display Mode

Pointer Tool

Select an object (or more than one) created with an analysis tool. It is also possible to select a graph itself.

Graph Slider Tool

This tool is used to slide the graph horizontally.

1 Select the within the graphed region and drag it to slide the graph.

To return a moved graph to its original position, double-click the on the tool box.
Horizontal Magnifying Glass Tool

This tool is used to magnify the graph horizontally without changing the height value.

1. Select and click a point within the graphed region. (With the clicked point serving as the center, the graph will be magnified to twice its size.)

2. To reduce the graph, hold down the shift key and click.

Double-click the on the tool box to restore the profile to its original state.
Vertical Magnifying Glass Tool

This tool is used to magnify the graph vertically without changing the width value.

1. Select and click a point within the graphed region. (With the clicked point serving as the center, the graph will be magnified to twice its size.)

2. To reduce the graph, hold down the shift key and click.

Double-click the on the tool box to restore the profile to its original state.
2.1 Display Mode

Magnifying Glass Tool

This tool is used to magnify the graph (horizontally and vertically).

1. Select and click a point within the graphed region. (With the clicked point serving as the center, the graph will be magnified to twice its size.)

2. To reduce the graph, hold down the shift key and click.

   Double-click the on the tool box to restore the profile to its original state.

Hand Tool

This tool is used to move (scroll) region of the image displayed.

Select and then drag the mouse pointer on the image.

Double-click the on the tool box to restore the profile to its original state.
2.2 Measure Mode

Horizontal BG Tool

Creates a horizontal background (BG) on the Profile.

1. With the Profile window in Measure mode, select the Horizontal BG tool from the tool box.

2. When you place the pointer within the graphed region, it will change to . At this time, the PSL value of the BG line will be displayed in realtime on the right side of the tool box, in keeping with the movement of .
3 Moving the mouse, move the Pointer to a background position and click to set.

4 By selecting **Copy BG Line...** from the Analysis menu, the horizontal BG line created here can be copied and applied to another profile.
If you double-click the Horizontal BG tool, the Profile Background dialog will be displayed and the BG line will be set in accordance with the input value.
Background Tool

This tool is used to set the background level of a graph.

1. Select from the tool box in Measure mode.

2. When the mouse pointer is placed within the graphed region, its shape will change as shown below.
3 On the first peak, click what will be the starting point for the background level (the upright portion). Then, move the mouse from point to point (they will be connected with a straight line), clicking as you go.

4 Double-click the last point.
5 To erase the background, select Clear BG Line from the Analysis menu.

<table>
<thead>
<tr>
<th>Analysis</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Renumber</td>
<td>Ctrl+R</td>
</tr>
<tr>
<td>Data Info...</td>
<td>Ctrl+F</td>
</tr>
<tr>
<td>Peak Search...</td>
<td>Ctrl+T</td>
</tr>
<tr>
<td>BG Search</td>
<td></td>
</tr>
<tr>
<td>Copy BG Line...</td>
<td></td>
</tr>
<tr>
<td>Clear BG Line...</td>
<td></td>
</tr>
<tr>
<td>Copy RF Ratio...</td>
<td></td>
</tr>
<tr>
<td>Option</td>
<td></td>
</tr>
</tbody>
</table>

Note: The background that can be set for one profile is limited to one line. Also, by dragging the handle on the line with the Pointer tool, you can freely change the position.
**Spline BG Tool**

Creates a smooth BG (background) line on the profile.

1. With the Profile window in Measure mode, select the Spline BG tool, ![Spline BG Tool](image)
   from the tool box.

2. Below, a background is created following the same procedure as when the background tool is used.
Integral Tool

This tool is used for measuring a portion from which the background created with the Background tool has been eliminated.

1 Select the Integral tool, ( ), from the tool box in Measure mode.

2 When the mouse pointer is placed within the graphed region, its shape will change as shown below.
3 Measure by dragging the graphed portion (peak) that you want to measure and releasing the mouse.

4 Measure each peak by dragging it.

5 Refer to Displaying Profile Results, p.D-53.

Note: With the Pointer tool, you can freely change the left and right edges of a peak.
Measure Profile Tool

This tool is a combination of the Background and Integral tools.

1. Select the Measure Profile tool, (* ), from the tool box in Measure mode.

2. When the mouse pointer is placed within the graphed region, its shape will change as shown below.
3 Drag from the starting point of the background level on the first peak (the upright portion) to the next point (they will be connected with a straight line), release the mouse button there, and measuring will be done.

4 Measure each peak by dragging it.

5 Refer to Displaying Profile Results, p. D-53.

Note: When peaks have been deleted and added, select Renumber from the Analysis menu to renumber the measurement Nos. for the profile graphs in order from the left side.
2.2 Measure Mode

Density Picker Tool

This tool is used to measure the value of one pixel on the graph.

1. Select the Density Picker, ( ), from the tool box in Measure mode.

2. When the mouse pointer is placed within the graph, its shape will change as shown below. At this time, the distance and the value for one pixel will be displayed in realtime beside the tool box.
3 Click each peak you want to measure. (The value for the position of the cursor will be measured.)

4 Refer to Displaying Profile Results, p. D-53.
Automatic Profile Background Recognition

**Auto BG...**

Automatically creates the background suitable for the smear components from the profile.

1. With the Profile window in Measure mode, select **Option** from the Analysis menu and then select **Auto BG...** from the submenu.

2. The Auto Background dialog will be displayed. In the input columns, input the parameters for background recognition.
2.2 Measure Mode

Lowest (Horizontal Line)

Creates a horizontal BG line from the minimum value on the profile.

Valley (Polygonal Line)

H. Ratio (A/B): %
V. Ratio (C/D): %

Creates an arbitrary BG line when the parameters for the horizontal and vertical directions are input (set).

H. Ratio (A/B): Parameter set for the horizontal direction

The parameter (% value) input here becomes the standard value when the created profile's total length (in the horizontal direction) is taken to be 100%. The smaller % value becomes, the more valleys are detected.

Example: As shown in the following illustration, when the interval between valleys is 10% of the total length, BG line "A" will be drawn if this parameter is set to under 10%. If it is set to 10% or more, BG line "B" will be drawn. (However, in this example, the influence of the parameter for the vertical direction has not been considered.)
2.2 Measure Mode

V. Ratio (C/D): Parameter set for the vertical direction

The parameter (% value) input here becomes the standard value when the maximum amplitude of the created profile (in the vertical direction) is taken to be 100%. The smaller % value becomes, the more valleys are detected.

Example: As shown in the following illustration, when the interval between the valley and the maximum value is 70% for the maximum amplitude, BG line "A" will be drawn if this parameter is set to under 70%. If it is set to 70% or more, BG line "B" will be drawn.

(However, in this example, the influence of the parameter for the horizontal direction has not been considered.)

Valley (Spline)

Subtracts a smooth background line.

H. Ratio (A/B) and V. Ratio (C/D) are the same as Valley (Polygonal Line).
3 After inputting the parameters, click **OK** on the Auto Background dialog.

4 With the Profile window in Measure mode, select **BG Search** from the Analysis menu.

<table>
<thead>
<tr>
<th>Analysis</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Renumber</td>
<td>Ctrl+R</td>
</tr>
<tr>
<td>Data Info...</td>
<td>Ctrl+F</td>
</tr>
<tr>
<td>Peak Search...</td>
<td>Ctrl+T</td>
</tr>
<tr>
<td><strong>BG Search</strong></td>
<td></td>
</tr>
<tr>
<td>Copy BG Line...</td>
<td></td>
</tr>
<tr>
<td>Clear BG Line...</td>
<td></td>
</tr>
<tr>
<td>Copy RF Ratio...</td>
<td></td>
</tr>
<tr>
<td>Option</td>
<td></td>
</tr>
</tbody>
</table>
2.2 Measure Mode

A background line like the following will be automatically created in accordance with the set parameters.

Note: When the Pointer is used to specify the valley point (when the Pointer is ▼) and the Ctrl key is pressed, the Pointer will change to ◄. In this condition, if you drag the mouse, the BG point will be copied. If you press the shift key, the Pointer will change to ◄. If you click the mouse in this condition, the BG point will be deleted.
Automatic Recognition of a Profile Measurement Region

**Peak Search**

It is possible to automatically set a Profile measurement region.

1. In Measure mode, select Peak Search... from the Analysis menu.

The following dialog will appear.

Peak : Peak will be recognized automatically.
Peak & BG : Peak and BG will be recognized automatically.
2.2 Measure Mode

2. Similar to the following illustration, a measurement region for the peak and BG will be automatically set.

![Diagram showing measurement region]

3. Select the Pointer tool from the tool box. By dragging the broken line on the region, you can make fine adjustments on the enclosure.

![Diagram showing fine adjustments]

Note: When peaks have been deleted and added, select Renumber from the Analysis menu to renumber the measurement Nos. for the profile graphs in order from the left side. When used together with the background tool, measurement is also possible.

4. Refer to Displaying Profile Results, p. D-53.
Setting Rf

Rf expresses the positional relationship of substance found with thin layer chromatography, which is calculated as a fraction.

\[
Rf = \frac{\text{Distance from origin to substance}}{\text{Distance from origin to solvent front}}
\]

1. Select Measure mode.

2. In Measure mode, drag the Rf normalizer and move from the origin of the lane to the front. When this has not been designated, from the starting point to the end point of the profile line will be selected.

3. Perform quantification.
   Especially when using the Density Picker tool, it is possible to define points.
   (When a uniform interval has been specified, the center of the largest peak will be the point.)
Measuring Distance Using the Rf Value
Mode Used: Profile - Measure
Function Overview: Measures distance in accordance with the Rf normalizer.

With the Profile window in Measure mode, by setting the Rf normalizer, the distance display can be measured so that the X-coordinate of the origin is always 0, no matter where it is moved.
An example of moving the X-coordinate by using the Rf normalizer follows.

4 When Profile/MW Result is selected from the Windows menu, Rf will be displayed.
2.2 Measure Mode

Applying the Rf Value

Copy RF Ratio

It is possible to apply to another profile the distance between the front and the origin of the Rf set for one measured lane from a profile.

1. Set the Rf that will serve as the standard.

2. Display another profile lane and set only the origin.

Note: Using the Start Line tool to set the origin makes operations easier.
3 Redisplay the profile serving as the standard and select Copy RF Ratio... from the Analysis menu.

4 Click YES and the ratio will be applied.
2.2 Measure Mode

Setting the Profile Display Method

1. Select Display... on the Option submenu from the Analysis menu.

![Analysis Menu]

2. The following Profile Display dialog will be displayed. After setting each item, click OK.

![Profile Display Dialog]

- Add a mesh to the graph.
- Modify scale in keeping with the profile.
- Display with log scale.
- Add a margin to the upper part of the largest peak.
- Scale can be set to the desired size.
Displaying Profile Results

1. Select Profile Result from the Windows menu.

   ![Windows Menu]

   - Image: Ctrl+1
   - View: Ctrl+2
   - Profile: Ctrl+3
   - Info: Ctrl+4
   - Quant Result: Ctrl+5
   - Profile/MW Result: Ctrl+6
   - Distance Result: Ctrl+7

2. A Profile Result table similar to the following will be displayed.

   ![Profile/MW Result Table]

<table>
<thead>
<tr>
<th>No.</th>
<th>Ln</th>
<th>PSL</th>
<th>Dist(mm)</th>
<th>RF</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>1</td>
<td>10.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>2</td>
<td>1</td>
<td>17.63</td>
<td>20.23</td>
<td>0.41</td>
</tr>
<tr>
<td>3</td>
<td>1</td>
<td>17.18</td>
<td>43.23</td>
<td>0.88</td>
</tr>
</tbody>
</table>
Molecular Weight Measurement

Molecular weight is measured from the distance of phoresis.

1. Set the lanes and bands within lanes in the sample.

Recognition of these lanes and bands can be done either automatically or manually.

When automatic recognition is set:
See C-58 for the method for using the Auto Lane/Band tools.

When manual recognition is set:
After lane setting with the Lane Profile tool (see C-62) or automatic recognition of lanes only has been set, set with the Band tool (see C-61).
2 Set the lane that will serve as the standard. After clicking on the image the lane that will be the standard (multiple lanes can also be selected), select Set... from the Lane Standard submenu of the Analysis menu.

3 The following dialog will be displayed.
4. Input the known molecular weights for each band in the MW column. Select the function to be used from the Convert Function column.

After setting the conditions, click **Curve Fit**. A calibration curve will be created.
5 If OK is clicked, along with a display (as in the following figure) of based on already known molecular weights, the unknown molecular weights will be measured from the calibration curve.

![Image of a figure showing molecular weight measurements]

6 If Profile/MW Result is selected from the Windows menu, the measurement results will be displayed.

```
<table>
<thead>
<tr>
<th>No</th>
<th>LI</th>
<th>Area Name</th>
<th>CEB(mm)</th>
<th>CEB(mm)</th>
<th>MW</th>
<th>Known</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>8</td>
<td>1</td>
<td></td>
<td>313.80</td>
<td>313.80</td>
<td>647.82</td>
<td>630.00</td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>1</td>
<td></td>
<td>349.60</td>
<td>349.60</td>
<td>540.75</td>
<td>530.00</td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>1</td>
<td></td>
<td>416.80</td>
<td>416.80</td>
<td>939.49</td>
<td>900.00</td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>1</td>
<td></td>
<td>460.60</td>
<td>460.60</td>
<td>900.00</td>
<td>900.00</td>
<td></td>
</tr>
<tr>
<td>12</td>
<td>1</td>
<td></td>
<td>579.80</td>
<td>579.80</td>
<td>194.16</td>
<td>210.00</td>
<td></td>
</tr>
<tr>
<td>13</td>
<td>1</td>
<td></td>
<td>704.00</td>
<td>704.00</td>
<td>90.47</td>
<td>100.00</td>
<td></td>
</tr>
<tr>
<td>14</td>
<td>1</td>
<td></td>
<td>503.60</td>
<td>612.60</td>
<td>52.83</td>
<td>52.20</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>2</td>
<td></td>
<td>524.80</td>
<td>526.89</td>
<td>172.13</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>2</td>
<td></td>
<td>507.80</td>
<td>506.85</td>
<td>102.05</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>3</td>
<td></td>
<td>258.80</td>
<td>258.49</td>
<td>652.56</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>4</td>
<td></td>
<td>522.80</td>
<td>524.97</td>
<td>174.85</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>4</td>
<td></td>
<td>528.80</td>
<td>527.95</td>
<td>110.19</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>5</td>
<td></td>
<td>31.80</td>
<td>14.80</td>
<td>1491.67</td>
<td>1490.00</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>5</td>
<td></td>
<td>47.80</td>
<td>50.89</td>
<td>1235.10</td>
<td>1200.00</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>9</td>
<td></td>
<td>94.80</td>
<td>91.89</td>
<td>1191.94</td>
<td>1190.00</td>
<td></td>
</tr>
</tbody>
</table>
```
3. Related Menu Functions
(used in both Quant and Profile)

3.1 Modifying the Unit

It is possible to change the unit for quantification used on the display or in the Result window, etc..

1. Select Density... on the Preferences submenu from the File menu.

2. The following Density dialog will be displayed. Each item can be set and the desired unit used.

* For the unit name, up to 3 English letters can be input.
3.2 Making Quantification Results into a File

Activate the Result window that you want to save (status of 6 parallel lines displayed on the title bar on the front screen of the desktop). The values for the items displayed at this time will be saved.

2. Select TEXT on the Export File submenu from the File menu.

3. When the file name and save destination is selected, a file will be formed (in TEXT format) and the following icon will appear.
3.3 Changing the Position of the Measurement No.

1. Select the measurement No. that you want to move and drag it to the desired position.

2. While moving the No., if you release the mouse button while holding down the shift key, the No. for the place at which you released the mouse and the No. you are moving will switch places.
Part E

Printing
With Image Gauge, printing can be done with the laser beam printer and the high-image-quality output printer, PG3000, PG3500, PG4000 or PSD400, connected to the Computer.

1. Printing an Image

1.1 Printing with a Laser Beam Printer

1. Activate the image window that you want to print.

2. Select Print... from the File menu. The following Print dialog will be displayed. At this time, the image window will be printed out as it is (although modifications are possible).
1.1 Printing with a Laser Beam Printer

It is possible to freely modify the print-out position and magnification. To leave off at a good magnification, use the Scale to make your selection.

3 Select Positioning or Trimming. (The initial setting is Positioning.)

Positioning: Designate the layout for the paper used in printing. When the centering box is clicked, the image will be printed at the same size in the center of the paper. However, by dragging the entire image, you can freely change where it will be printed.

When size is modified via Scale %, the size that the image is printed out will be modified. (When 100% is set, the image will be printed in its actual size.)

See page E-6 for printing in actual size an image captured from an external device (images read by other than the IP Reader or Fluorescent Reader).

Trimming: Designate (trim) the region of the image that will be printed. (Initially, the state of the image window will be displayed.)

Note: To position an image that has been trimmed, after designating the region to be printed, switch back again to Positioning.
It is possible to print out with the image the objects made with each mode.
Make selections from the ( ) pulldown menu for Information: .
- Annotation: For printing out with the image the objects made in Annotation mode.
- Quant: For printing out with the image the objects made in Quant mode.
- Profile: For printing out with the image the objects made in Profile mode.
- Distance: For printing out with the image the objects made in Distance mode.

* A multiple number of modes can be selected.
4 When Options... is clicked, the following Printout Options dialog will be displayed. After setting the necessary items, click OK.

Comment: For putting a comment at the edge of the image region. Input the comment in the Comment box.
- None: When no comment is needed.
- Top: Puts the input comment at the top.
- Bottom: Puts the input comment at the bottom.

CLUT: Puts the Color Look Up Table at the edge of the image area.
- None: When no CLUT is needed.
- Top: Puts the CLUT at the top end.
- Bottom: Puts the CLUT at the bottom end.

Back: Specifies background color for the comment and CLUT.
- None: When no background color is needed.
- White: Specifies white for background color.

Printer Quality: Determines output pixel size. (Image quality will be changed.)
- Best: Applies image pixel size to output. (Results in attractive output but printing time is long.)
- Better: Prints images at standard pixel size.
- Good: Prints images with pixel size on the CRT display. (Output is coarse, but printing time is short.)

Adjust Width/Height: Allow actual output size to be finely adjusted in increments of 0.1%.

5 When you click [OK] in the Print dialog, the setting dialog for the attached printer drive will be displayed. Set the necessary items and print.
Printing in actual size an image captured from an external device (images read by other than IP Reader/Fluorescent Reader)

By adding distance information to an image, it is possible to print the image in actual size captured by an external device.

1. Open the target image and change mode to Distance. Measure the distance between specified points (where the actual distance is known) and then display the result table.
2 Activate the result table and select Distance Calibration... from the Analysis menu.

3 When the following display appears, input the known distance in the Known Length box.
4 Select Print... from the File menu to display the Print dialog.

5 Select Use for Calibrated in the Print dialog below.

Calibrated: [ ] No
[ ] Use

It is thus possible to print the image with the calibrated distance. If Scale is set to 100%, actual size printing is possible.
1.2 Printing with the PG3000, PG3500, PG4000 or PSD400 High-Image-Quality Printer

1. Activate the image window you want to print.

2. Select Print Pictro... from the File menu. The Print by PICTRO dialog shown below will be displayed.
1.2 Printing with the PG3000, PG3500, PG4000 or PSD400 High-Image-Quality Printer

It is possible to freely modify the print-out position and magnification. To leave off at a good magnification, use the Scale to make your selection.

Centering box
Lay out the image so that it will be printed out in the center of the paper.

It is possible to freely modify the print-out position and magnification. To leave off at a good magnification, use the Scale to make your selection.

1:1 Image When Scale is 100%, output will be at the actual size. Use Options... for fine adjustments. See page E-6 for printing in actual size an image captured from an external device (images read by other than the IP Reader or Fluorescent Reader).

1:1 Pixel Image will be output with its pixels made to correspond to PICTRO dpi.

4 Select Positioning or Trimming. (The initial setting is Positioning.)

Positioning Designate the layout for the paper used in printing.
When the centering box is clicked, the image will be printed at the same size in the center of the paper. However, by dragging the entire image, you can freely change where it will be printed.

Trimming Determine the pixel size for output, making your selection from the 1:1 Pixel pulldown menu.
You can designate the region of the image to print. (Initially, the window will be displayed.)
After designating the region, click Print... and printing will be done.

Note: To position an image that has been trimmed, designate the region to be printed and then switch to Positioning.
1.2 Printing with the PG3000, PG3500, PG4000 or PSD400 High-Image-Quality Printer

Select whether to position the image horizontally or vertically in relation to paper.

Direction: □ □

Select paper size for printing.

Paper: □ A4 □ A3

Note: Paper sizes
Sizes of the paper that can be used differ depending on the connected printer.

(1) When PG3000, PG3500 is connected:
A4/B5 or Letter/Half L (for overseas)
  * When Letter/Half L is used, selecting Print Pictro... in the File menu while holding the option key down, selection in Paper Size will be changed.

(2) When PG4000 or PSD400 is connected:
Paper sizes that the software can handle are limited according to PG4000 specifications.
Available paper size is automatically changed in accordance with the paper width specified for PG4000 or PSD400.

When paper width is 297mm: A3/A4
When paper width is 127mm: 2L (5R for overseas)
When paper width is 297mm (for overseas): D-Letter/Letter
5 It is possible to print out with the image the objects made with each mode. Select the mode that has object in Information: options. Selected mode will be checked ☑.

<table>
<thead>
<tr>
<th>Mode</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Annotation</td>
<td>For printing out with the image the objects made in Annotation mode.</td>
</tr>
<tr>
<td>Quant</td>
<td>For printing out with the image the objects made in Quant mode.</td>
</tr>
<tr>
<td>Profile</td>
<td>For printing out with the image the objects made in Profile mode.</td>
</tr>
<tr>
<td>Distance</td>
<td>For printing out with the image the objects made in Distance mode.</td>
</tr>
</tbody>
</table>

* A multiple number of modes can be selected.

6 When Options... is clicked, the following Pictro Print Options dialog will appear. After setting the necessary items, click OK.

Comment: For putting a comment outside of the image region. Input the comment in the Comment box.
- None: When no comment is needed.
- Top: Puts the input comment at the top.
- Bottom: Puts the input comment at the bottom.

CLUT: Puts the Color Look Up Table at the edge of the image area.
- None: When no CLUT is needed.
- Top: Puts the CLUT at the top end.
- Bottom: Puts the CLUT at the bottom end.

Back: Specifies background color for the comment and CLUT.
- None: When no background color is needed.
- White: Specifies white for background color.

Adjust Width/Height: Allow actual output size to be finely adjusted in increments of 0.1%.
Additional Information
When you select Print Pictro... from the File menu while holding the Alt key down, Paper Size will change to Half L/Letter.

7 Click OK in the Print by PICTRO dialog and then print.
2. Printing Quantified Results

2.1 Using Quant Result for Printing Quantified Results

1. Activate the Quant Result window on the desktop.

![Quant Result Window]

2. Select Print... from the File menu.

![Print Menu]

3. The following dialog will appear. Select which of the two printing methods you want by clicking.

![Select Printing Method]

- Normal: Prints out all the numbers for quantification results altogether.
- Group: Prints out by group, using separate pieces of paper for each.

4. When the printer driver dialog appears, print.
2.2 Printing Quantified Results Using Profile Result

1. Activate the Profile Result window on the desktop.

```
Profile\NW Result

<table>
<thead>
<tr>
<th>No</th>
<th>Line</th>
<th>Area Name</th>
<th>FSL</th>
<th>FSL-B6</th>
<th>Ratio</th>
<th>% of L</th>
<th>Dist.(mm)</th>
<th>FF</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>1</td>
<td></td>
<td>32.36</td>
<td>24.77</td>
<td>------</td>
<td>15.34</td>
<td>29.00</td>
<td>0.20</td>
</tr>
<tr>
<td>2</td>
<td>1</td>
<td></td>
<td>68.51</td>
<td>55.51</td>
<td>------</td>
<td>56.72</td>
<td>40.48</td>
<td>0.58</td>
</tr>
<tr>
<td>3</td>
<td>1</td>
<td></td>
<td>24.56</td>
<td>16.67</td>
<td>------</td>
<td>10.73</td>
<td>46.88</td>
<td>0.46</td>
</tr>
<tr>
<td>4</td>
<td>1</td>
<td></td>
<td>27.97</td>
<td>20.00</td>
<td>------</td>
<td>12.97</td>
<td>52.00</td>
<td>0.60</td>
</tr>
<tr>
<td>5</td>
<td>1</td>
<td></td>
<td>21.33</td>
<td>16.43</td>
<td>------</td>
<td>10.57</td>
<td>57.00</td>
<td>0.64</td>
</tr>
<tr>
<td>6</td>
<td>1</td>
<td></td>
<td>29.90</td>
<td>22.01</td>
<td>------</td>
<td>14.10</td>
<td>76.00</td>
<td>0.53</td>
</tr>
</tbody>
</table>
```

2. Select Print... from the File menu. When the printer dialog appears, set the necessary items and click the Print button.

3. The printer driver dialog will appear. Execute printing.

2.3 Printing Result Table Using Distance Result

Print the result table according to the same procedures as those used in 2.2. Profile Result above.
3. Printing Profile Graph

1. Activate the target profile graph.

2. Select Print... from the File menu.

3. When the printer driver dialog appears, set the necessary items and click the Print button.
Part F

Convenient Menu Functions to Learn
1. Opening a File

**Import File**

Even if the file has been made with another application (or system), if it is in RAW format (data-only format), Bit Map file or TIFF (Index Color, RGB full color, 16bit / 8bit gray), it will be possible to open that file in Image Gauge. Doing so will make it possible to create a calibration curve and conduct quantification.

1. Select Custom... (or BMP...) on the Import File submenu from the File menu.
1. Opening a File

1. Opening a File

1-1 If the file is in RAW format (data-only format), select Custom...
The following Import File dialog will be displayed. Input the
values for depth, offset, and width and height, click OK, and
open the file.

![Import File dialog]

1-2 If the file is in Bit Map format, select BMP... and open the file.

1-3 If the file is in TIFF format, select TIFF... and open the file.

2 Specify the name for the file in the following dialog.
2. Saving BMP and TIFF Files

It is possible to convert an image, Profile, Result window, or region specified with the image selector to BMP or TIFF file format.

1. With the window active, select TIFF... or BMP... on the Export File pulldown menu from the File menu.

2. Specify the file name and storage file and save. (When it has been saved, icons like the following will appear.)

* When a BMP file is selected, following display will be displayed.

Original... : Converts to BMP file without thinning out the pixel from original image.
Window... : Converts to BMP file according to pixel size on the monitor.
* When a TIFF file is selected, following display will be displayed.

![Image Resolution to save]

- **Window...** : Converts to TIFF file according to pixel size on the monitor.
- **Original(8bit)** : Converts to 8bit gray TIFF file without thinning out the pixel size from original image. For 2byte data, converts to 8bit gradation according to maximum and minimum Range Scope values.
- **Original(16bit)** : Converts to 16bit gray TIFF file without thinning out the pixel size from original image. This selection is not available for an 8bit image.
3. File Menu

Revert
This function rereads the original file for the currently open image and opens it. However, this cannot be used if there is no image file.

Preference - Display
This file is for setting the image display conditions.

![Image Display]

- **Paint Saturated Data to Red**: Displays over-saturated pixels in red in all modes.
- **Always Show All Entry Area**: Displays the ROI, lane or characters specified in each mode also in other modes.
- **Set Positive as Default Display**: Displays images in positive when they were opened the first.
- **Set Linear as Default Display**: Displays gradations using Linear as the tone curve when images were opened the first.
- **Show Annotation Information**: Displays arrows and characters in Annotation mode.
- **Show Quant Area Number**: Displays the number of quantification area specified in Quant mode.
- **Show Profile Area Number**: Displays the line or lane number specified in Profile mode.
- **Show Band Size Line**: Displays the contour line in measurements of molecular weight in Profile mode.
- **Show Distance Item Number**: Displays the line number specified in Distance mode.

Preference - Distance
This function is used to set the unit of distance.

![Distance Unit]

- **Distance & Area Unit**: mm, cm, mm, pixel
- **Scale**: 1.000
- **Original**: 0.200 mm = 1 pixel
- **Convert to**: 0.200 mm = 1 pixel

Cancel | OK
4. Edit Menu

**Standard Mag**
Restores images, Profiles, etc., enlarged with the Magnifying Glass to their initial condition.

5. Analysis Menu

**Sort**
Sorts the measurement Nos. on the Result window in numerical order. (When group settings are made, this will be done for each group.)
Renumber
Assigns new measurement Nos. to compensate for missing Nos.

6. Image Menu
Change Color
Specify the order of colors on the pseudo-color display.
Index
## Index

### A
- About This Quant .......................................................... D-13
- Adjuster ...................................................................... B-17
- Analysis Modes ................................................................. C-2
- Angle Tool .................................................................. C-75
- Annotation Mode .............................................................. C-10
- Area Name .................................................................... D-2
- Area of the Measured Region ........................................ D-2
- Arrow Tool ..................................................................... C-15
- Auto Background ............................................................ D-40
- Auto Lane & Band ......................................................... C-61
- Automatic Lane / Band Tool ........................................ C-58

### B
- Background ....................................................................... D-7
- Background Tool .............................................................. D-30
- BMP Stamp Tool .............................................................. C-19
- Brightness/Contrast ........................................................... B-15

### C
- Calibration ....................................................................... D-16
- --- Curve ....................................................................... D-16
- Centering Box .................................................................. E-3, E-7
- Change Color .................................................................... F-7
- Clear BG Line ..................................................................... D-32
- Clip Image ......................................................................... C-11
- Close Box .......................................................................... B-14
- Color Type ......................................................................... B-15
- Comment Input Box ........................................................... C-21
- Convert Function ................................................................. D-56
- Copy RF Ratio .................................................................... D-50
- Copy BG Line ..................................................................... D-28
- Curve ................................................................................ D-18
  - --- Adjuster ................................................................ D-18
  - --- Box ........................................................................ D-18

### D
- Data Info .......................................................................... D-13
- Data Information ............................................................... D-2
- Density .............................................................................. D-17
- Density Calibration ............................................................. D-17
- Density Picker Tool ............................................................. C-5, D-38
- Display Mode ..................................................................... D-21
- Displaying Profiles ............................................................ C-72

### E
- Enter Rect Coordinate ...................................................... C-12
- Exit ................................................................................ B-3
- Export File .......................................................................... F-4

### F
- File .................................................................................. C-21
- --- Info ........................................................................... C-21
- --- Information ............................................................... C-21
- Free-Division Matrix Tool .................................................. C-36
- Free Hand Tool ................................................................. B-21

### G
- Global .............................................................................. D-9
- Graph Slider Tool ............................................................. D-23
- Group ............................................................................. D-2, D-4
- Grow Handle ..................................................................... C-23

### H
- Hand Tool ......................................................................... C-9, D-26
- Handle ............................................................................. D-31
- Horizontal GB Tool ............................................................ D-27
  - --- Magnifying Glass Tool ............................................ D-24

### I
- Image .................................................................................. B-8
  - --- Reader .................................................................... B-8
  - --- Resize% ................................................................... C-11, C-19
  - --- Selector Tool ........................................................... C-10
  - --- Trimming Option ...................................................... B-10
- Import
  - --- File ......................................................................... F-2
  - --- Function .................................................................. B-21
- Index .................................................................................. D-2
- Info Stamp Tool ............................................................... C-16
- Information Stamp ............................................................. C-16
- Install ............................................................................... A-4
- Integral Tool ...................................................................... D-34
- Interval Tool ..................................................................... C-73
Ladder Tool ......................................................... C-30
Lane Profile Tool .................................................. C-55
Linear ................................................................. B-16
Line Profile Tool ................................................... C-54
Local ................................................................. D-7

Magic Wands Tool ................................................. C-46
Magnification Ratio ................................................ B-14
Magnifying Glass Tool ........................................... C-7, D-26
Making an ROI Data File ......................................... C-49
Making Quantification Results Into a File ............... D-59
Matrix Dimension .................................................. C-34
Matrix Tool ........................................................... C-33
Measure Mode ..................................................... D-20, D-27
Measure Profile Tool ............................................ D-36
Measurement Number .......................................... D-2
Memory for Application ...................................... A-2
Mode Selector ...................................................... B-14
Molecular Weight Measurement ......................... D-54
Moving ............................................................... B-11

Negative Gray ..................................................... B-15

Open ................................................................. B-8
Oval Tool ........................................................... C-28

Peak Aid ........................................................... C-66
Peak Search ......................................................... D-45
Percent of Group Each Value Represents ............... D-2
PG3000 ............................................................... E-9
PG4000 ............................................................... E-9
Pictro Print Options ............................................. E-12
Pointer Tool ....................................................... C-3, D-23
Polygon Tool ....................................................... C-26
Positioning ......................................................... E-3, E-10
Positive Gray ....................................................... B-15
Preference
--- Density ......................................................... D-58
--- Display ......................................................... F-6
--- Distance ....................................................... F-6
Print ................................................................. E-2
--- Pictro .......................................................... E-9
Printing Quantified Results ................................ E-14
Printout Options ................................................ E-5

Profile
--- Background .................................................. D-29
--- Display ......................................................... D-52
--- Mode ............................................................ C-54
--- Number ....................................................... D-20
--- Result .......................................................... D-55
--- Width .......................................................... C-65
PSL ................................................................. C-6
Pulldown Switcher .............................................. D-21

QL ........................................................................ C-6
Quant
--- List Box ......................................................... D-2
--- List Item ....................................................... D-3
--- Mode ............................................................ C-23
--- Result Table .................................................. D-15
--- Table ........................................................... D-15

Range Scope ....................................................... B-22
--- Box .............................................................. B-22
Rectangle Tool .................................................... C-23
Renumber .......................................................... F-8
Resetting .......................................................... B-11
Resizing ............................................................ B-11
Revert ............................................................... F-6
Rf ................................................................. D-47
--- Normalizer .................................................... D-47
Slanted Rectangle Tool ....................................... C-29
Rotate/Flip ....................................................... B-10
Rotation Handle ............................................... C-29

Save ................................................................. B-3
Scale Bar ........................................................... C-18
--- Tool ............................................................. C-18
Scroll Box .......................................................... B-14
Select Printing Method ...................................... E-14
Select Profiles ................................................... D-22
Sequential Switcher ........................................... D-21
Sigmoid ............................................................. B-15, B-17
Size Box ........................................................... B-14
16 color ............................................................. B-15
Slide Handle ..................................................... C-31
Smile Lane Profile Tool ..................................... C-56
Stamp Setup ..................................................... C-17
Standard .......................................................... D-10
--- Mag ............................................................. F-7
Start Line Tool ................................................... C-58
T
Text & Font .............................................................. C-13
Text Tool .............................................................. C-13
32 color ................................................................. B-15
Titer Plate Tool ...................................................... C-44
Title Bar ................................................................. B-14
Tone Curve ............................................................ B-15, B-18
Tool Box ................................................................. B-14
--- Scroll Arrow ....................................................... B-14
Trace Resolution ................................................... C-25, C-45
Triangular .............................................................. B-15, B-20
Trim Again ............................................................. B-10
Trimming ............................................................... B-10, E-3, E-10
--- Box ................................................................. B-10

U
Ungroup ................................................................. D-5
Unit .......................................................................... B-14

V
Value
--- per 1mm².............................................................. D-2
--- per 1mm² Background Subtracted ......................... D-2
--- per 1mm² with Background Subtraction .................. D-2
Vertical Magnifying Glass Tool ................................. D-25
View .......................................................................... B-25
View Scope ........................................................... B-22
Read this first:

Thank you for purchasing FUJIFILM Science Lab L Process Ver. 2.0. Before using this software, please be aware of the following important items.

Regarding the use of Science Lab 2001 L Process software:
When you first started using this software, you agreed to the usage conditions specified below, and Fuji Photo Film Co., Ltd. granted you a license to use the Science Lab 2001 L Process software.
The ownership rights to the software belong to Fuji Photo Film Co., Ltd. Part of the ownership rights to this software belongs to ALTURA SOFTWARE, INC. In keeping, this software is not something that is sold to you but something that Fuji Photo Film Co., Ltd. grants you a license to use. The recording media is yours, but the ownership rights to the software remain with Fuji Photo Film Co., Ltd.

LICENSE TERMS
1) You are granted the use of Science Lab 2001 L Process for a single CPU or a single unit within multiple CPUs. Hence, in a computer network environment, a separate Science Lab 2001 L Process license will be required for each unit that will be using the software.
2) You are allowed to copy Science Lab 2001 L Process onto different media for backup and program execution purposes.

USAGE LIMITATION
1) No copying, modification or transfer of Science Lab 2001 L Process other than specified by the terms of the usage license is allowed.
2) No reverse compiling or reverse assembling of Science Lab 2001 L Process done for the purpose of turning Science Lab 2001 L Process into a readable format is allowed.
3) No lending or distribution of Science Lab 2001 L Process or a part thereof for profit is allowed.
4) No derivative copyrighted product can be produced from Science Lab 2001 L Process, or modifications of it, or in conjunction with other software.

NOTES
1) Reproduction of parts or all of the contents of this manual without permission is prohibited.
2) The contents of this manual are subject to change without notice.
3) This manual has been prepared with utmost care. However, if you have any questions or find errors, omissions, etc., please contact us.
4) We will not be liable for any effects incurred from the use of this device.

Copyright Reserved
<Reprint and/or reproduction of parts or whole of this manual is prohibited.>
Copyright © 1998-1999 by Fuji Photo Film Co., Ltd.

Microsoft is a registered trademark of Microsoft Corporation in the U.S.
Windows®, Windows® 95, Windows® 98 and Windows NT® are registered trademarks of Microsoft Corporation in the U.S.
Pentium is a registered trademark of Intel Corporation in the U.S.
Other company names and product names mentioned in this document are the trademarks or registered trademarks of those companies.
1 "Portions of this product are copyright ©1991-1997 Altura Software Inc. All rights reserved."

2 "COMPANY’S LICENSOR (S) MAKES NO WARRANTIES, EXPRESS OR IMPLIED, INCLUDING WITHOUT LIMITATION THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE, REGARDING THE SOFTWARE. COMPANY’S LICENSOR (S) DOES NOT WARRANT, GUARANTY, OR MAKE ANY REPRESENTATIONS REGARDING THE USE OR THE RESULTS OF THE USE OF THE SOFTWARE IN TERMS OF ITS CORRECTNESS, ACCURACY, RELIABILITY, CURRENTNESS, OR OTHERWISE. THE ENTIRE RISK AS TO THE RESULTS AND PERFORMANCE OF THE SOFTWARE IS ASSUMED BY YOU. THE EXCLUSION OF THE IMPLIED WARRANTIES IS NOT PERMITTED BY SOME STATES. THE ABOVE EXCLUSION MAY NOT APPLY TO YOU."

3 "IN NO EVENT WILL COMPANY’S LICENSOR (S), AND THEIR DIRECTORS, OFFICERS, EMPLOYEES, OR AGENTS (COLLECTIVELY "COMPANY’S LICENSOR") BE LIABLE TO YOU FOR ANY CONSEQUENTIAL, INCIDENTAL, OR INDIRECT DAMAGES (INCLUDING DAMAGES FOR LOSS OF BUSINESS PROFITS, BUSINESS INTERRUPTION, LOSS OF BUSINESS INFORMATION, AND THE LIKE) ARISING OUT OF THE USE OF, OR INABILITY TO USE, THE SOFTWARE EVEN IF COMPANY’S LICENSOR HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. BECAUSE SOME STATES DO NOT ALLOW THE EXCLUSION OR LIMITATION OF LIABILITY FOR CONSEQUENTIAL OR INCIDENTAL DAMAGES, THE ABOVE LIMITATIONS MAY NOT APPLY TO YOU."
This equipment cannot be taken to or used in a country or area where power supply specifications differ from those in the country or area where it was originally installed.

**JAPAN**

This device is in compliance with the VCCI standards established by the conference on self-imposed control of noise interference caused by information devices for the purpose of preventing interference in commercial and industrial areas caused by Class 1 information devices (information devices to be used in commercial and industrial areas). If this device is used in residential areas adjacent to them, it may cause radio disturbance.

This device must be handled correctly in accordance with this operation manual.

**United States of America**

This equipment generates, uses, and can radiate radio frequency energy and if not installed and used in accordance with the instructions manual, may cause interference to radio communications.

It has been tested and found to comply with the limits for a Class A computing device pursuant to Subpart J of part 15 of FCC Rules, which are designed to provide reasonable protection against such interference when operated in a commercial environment.

Operation of this equipment in a residential area is likely to cause interference in which case the user at his own expense will be required to take whatever measures may be required to correct the interference.

**Canada**

This digital apparatus does not exceed the Class A limits for radio noise emission from digital apparatus as set out in the radio interference regulations of the Canadian Department of Communications.

“Le présent appareil numérique n’émet pas de bruits radioélectriques dépassant les limites applicable aux appareils numériques de la class A prescrites dans le Règlement sur le brouillage radioélectrique édicté par le ministère des Communications du Canada.”
Contents

1. L Process Ver 2.0........................................................................................................................................ 1
2. Installing/Uninstalling the L Process ...................................................................................................... 3
   2.1 Installing the L Process .................................................................................................................... 3
   2.2 Uninstalling the L Process .............................................................................................................. 10
3. Starting Up and Quitting this Software .............................................................................................. 12
   3.1 Starting Up ..................................................................................................................................... 12
   3.2 Quitting ......................................................................................................................................... 13
4. Viewing an Image .................................................................................................................................... 14
   4.1 Image Reading ................................................................................................................................. 14
   4.2 Opening an Image File .................................................................................................................. 14
   4.3 Window When Image is Opened .................................................................................................... 17
   4.4 Changing the Display ...................................................................................................................... 18
      4.4.1 Changing the Display Color ................................................................................................... 18
      4.4.2 Adjusting Gradation .............................................................................................................. 18
      4.4.3 Magnifying and Reducing the Image Display ....................................................................... 23
      4.4.4 Enhancing Contrast .............................................................................................................. 25
      4.4.5 Clipping Out a Region ......................................................................................................... 27
   4.5 Measuring the Angle ......................................................................................................................... 29
5. Processing .......................................................................................................................................... 31
   5.1 Applying FFT ................................................................................................................................ 31
      5.1.1 Applying the Circular Filter ................................................................................................. 34
   5.2 Applying Inverse-FFT .................................................................................................................... 35
      (a) Circle Mask tool ..................................................................................................................... 36
      (b) Donut Mask tool .................................................................................................................. 37
      (c) Twin Mask tool ..................................................................................................................... 38
      (d) Lane Mask tool .................................................................................................................... 39
      (e) Freehand Mask tool .............................................................................................................. 40
      (f) Array Mask lane ...................................................................................................................... 41
   5.3 Saving the FFT Image ....................................................................................................................... 43
Contents

5.4 Applying Filter ......................................................................................................................... 44
   (a) Applying Averaging ............................................................................................................... 45
   (b) Applying Median ................................................................................................................. 47
   (c) Applying Gradient .............................................................................................................. 48
   (d) Applying Roberts ............................................................................................................... 50
   (e) Applying Sobel .................................................................................................................... 51
   (f) Applying Laplacian ............................................................................................................. 52
   (g) Applying Prewitt ................................................................................................................. 53
   (h) Applying Marr-Hildreth ..................................................................................................... 54
   (i) Applying High-Pass ........................................................................................................... 55
   (j) Applying Unsharp Mask .................................................................................................. 56
   (k) Applying Custom .............................................................................................................. 57

5.5 Inverting the Image Data .......................................................................................................... 58

5.6 Filtering the Hot / Cold Spot .................................................................................................... 59

5.7 Rotate Function ....................................................................................................................... 61

5.8 Flip Function .......................................................................................................................... 65

5.9 Joint Function ......................................................................................................................... 67

5.10 Modifying the Image Aspect Ratio ......................................................................................... 69

5.11 Using Arithmetic ................................................................................................................... 71

5.12 Overlapping the Image Manually .......................................................................................... 74

5.13 Overlapping the Image Semi-automatically ......................................................................... 76
   (a) Markspot tool ...................................................................................................................... 76
   (b) Markline tool .................................................................................................................... 80

5.14 Displaying Calculation Overflow/Underflow During Image Processing ............................. 84

5.15 Displaying Composed Fluorescent Images ......................................................................... 85

5.16 Displaying the Contour Line .............................................................................................. 87

6. Displaying Multiple Images ..................................................................................................... 90
   (a) Cascade ............................................................................................................................ 90
   (b) Tile ................................................................................................................................. 91

7. Saving ........................................................................................................................................ 92
   (a) Save ................................................................................................................................. 92
   (c) Export ............................................................................................................................ 92
   (b) Save as .......................................................................................................................... 92

8. Undoing Processing .................................................................................................................. 94

9. Viewing Image Information ....................................................................................................... 95

10. Printing .................................................................................................................................... 96
   10.1 Printing Image on Laser Beam Printer ............................................................................... 96
   10.2 Easily Printing Images Out on Pictrography 3000/ Pictrography 3500/ Pictrography 4000 or Pictrostat 400 97
1. L Process Ver.2.0

1. L Process Ver.2.0 (hereinafter referred to as "this software,") is for analyzing and quantifying the image data input from the Image Plate Reader (IP Reader) originally introduced to the market by Fuji Photo Film Co., Ltd. and for image analysis and quantification of image data in RAW format.

2. The sample screens throughout this manual have been selected and used provided that they match the functions described and the assumed selections and items that appear. In keeping, when reading the manual, adapt it to the images that you actually deal with.

3. For details on image reading, refer to the operation manual that accompany the Image Readers.

4. Use of this software has been confirmed for the following system combinations. If other combinations are used, correct software operation cannot be guaranteed.

1. Standard Hardware Configuration

- Computer main unit:
  DELL's OptiPlex GX150-933MT (CPU: Pentium II-933MHz; built-in HDD: ATA-support EIDE drive)
  Includes keyboard, keyboard cable, mouse and mouse cable.
  * Capacity of the main memory will be as follows, depending on the image type to be processed. (Figures shown between parentheses indicate maximum image size. For analysis of two or more types of image, use the maximum one.)

<table>
<thead>
<tr>
<th>Image Reader and Max. Image Size</th>
<th>Main Memory</th>
</tr>
</thead>
<tbody>
<tr>
<td>BAS-1000 (2MB), BAS-1500 (16MB)</td>
<td>64MB</td>
</tr>
<tr>
<td>BAS-2000 (64MB), BAS-3000 (12MB)</td>
<td></td>
</tr>
<tr>
<td>BAS-2500 (64MB), BAS-1800 (40MB)</td>
<td>96MB</td>
</tr>
<tr>
<td>FLA-2000 (64MB), FLA-8000 (136MB)</td>
<td></td>
</tr>
<tr>
<td>BAS-5000 (160MB)</td>
<td>224MB</td>
</tr>
<tr>
<td>LAS-1000 (2.5MB)</td>
<td>64MB</td>
</tr>
<tr>
<td>FLA-5000 (562MB)</td>
<td>768MB</td>
</tr>
</tbody>
</table>

- Peripheral devices:
  ○ Monitor: DELL's D1025HT
  17" Trinitron monitor, with connection cables; supplied together with the computer main unit shown above.
  ○ SCSI board: Adaptec's AHA-2930LP
  Windows® 95 driver software is supplied. The OS bundle is used.
  ○ LBP: LBP-3500 (Canon)
2. Standard Software Configuration

- Operating system:
  - Japanese and English Windows® 98 SE
  - Japanese and English Windows® 2000
  - Japanese and English Windows® NT4.0 / Service Pack 5
  - Pre-installed system is used.

- File system:
  - Windows 98: FAT32
  - Windows 2000: NTFS
  - Windows NT: NTFS

- Analyzing software:
  - Full set of Science Lab (Image Gauge + L Process)

3. High-Quality Image Output Options

- PG3000 (48MB), PG3500, PG4000 (120MB), PSD400:
  - Possible to connect one Pictrography only.

This manual has been prepared provided that users have ever operated the computer in Windows® 98, 2000 and/or Windows® NT4.0 environment and have a fair knowledge of the basic operation and displays.
2. Installing/Uninstalling the L Process

2.1 Installing the L Process

1. Insert the CD-ROM labeled Science Lab into the CD-ROM drive.

2. Double-click the Science Lab folder in the CD-ROM to open it.

3. Double-click the Setup.exe icon.

* The setup.exe icon can also be set up using Add/Remove programs on the control panel.
When installing the Science Lab for the first time, proceed to 4. For a computer in which the Science Lab of the previous version has already been installed, a dialog shown below will appear.

![Dialog 1]

The new software cannot coexist with the previous version software in the same machine. If [Yes] is selected, the previous-version software will be uninstalled. The confirmation dialog shown below will appear. Select [Yes] for uninstalling the previous-version software.

![Dialog 2]
4 Carefully read the messages, warnings, etc., in the Welcome dialog that follows and then click the Next button to proceed to the Software License Agreement dialog.

5 Carefully read the contents of the Software License Agreement dialog that follows. If you agree to the conditions of the agreement, click the Yes button to proceed to the Information dialog.
6 Click the **Next >** button in the information dialog that follows to proceed to the Customer Information dialog.

![Customer Information dialog]

7 Type your name and company in the Customer Information dialog box, and then click the **Next >** button. After confirming the entries in the Registration Confirmation dialog box, click the **Yes** button to proceed to the Choose Destination Location dialog box.

![Registration Confirmation]

8 Check the destination folder (where the software is installed) that appears in the Choose Destination Location dialog box. If you prefer, click the **Next >** button to move to Step 11, the Select Program Folder dialog box. If you want to change the folder, click the **Browse** button to go to the Choose Folder dialog box.

![Choose Destination Location]
9 Specify the destination where the [Science Lab] software should be installed and then click the OK button to return to the Choose Destination Location dialog.

10 Click the Next button in the Choose Destination Location dialog that follows to proceed to the Select Program Folder dialog.
11 In the Select Program Folder dialog box, type the name of a program folder for registering the start-up menu or select one from the box below, and then click the button to proceed to the Start Copying Files dialog box.

* The default folder name is Science Lab. If you accept this, click the button to go to the Start Copying Files dialog box.

12 Confirm the content in the following Start Copying Files dialog and then click the button. (Installation will begin.)
13 After the installation has been completed, the following dialog box appears. If you want to see the README file or to start Image Gauge soon, select the respective check boxes. Click the **Finish** button to finish the installation.
2.2 Uninstalling the L Process

1. Open the Control Panel and double-click Add/Remove Programs.

2. Select [Science Lab] in the dialog that follows and then click the Add/Remove button.
3. When the following confirmation dialog appears, click [Yes] if you wish to uninstall the software. (Uninstallation will then begin.)

![Confirm File Deletion dialog](image)

4. The following dialog will appear to proceed with uninstallation. When all procedures have been completed, the [OK] button will be activated. Click the [OK] button to complete uninstallation.

![Remove Programs From Your Computer](image)
3. Starting Up and Quitting this Software

3.1 Starting Up

1. Double-click the icon.

A few seconds after the opening dialog appears, the application will start up.
3.2 Quitting

1. Select Exit from the File menu.

When L Process file format has been specified, the quitting procedure will continue as follows.

2. The following dialog will be displayed asking whether or not you want to save the image data analyzed using L Process.

3. To save the processing results, click **Yes**. Click **No** if you don't want to save the processing results.

Note: Processing data will be added to the L Process image file. File size will increase or decrease according to the volume of the data. Therefore, always pay attention to the data storage capacity of the media.
4. Viewing an Image

4.1 Image Reading

See the separated "Image Reader Operation Manual."

4.2 Opening an Image File

Open... / Import...

1. Select Open... or Import... from the File menu to display the image file dialog.
2 When Open... is selected, double-click the file name you want to open in the image file dialog like that shown below.

![Image file dialog](image)

When the desired file cannot be found in the current folder, use the drop-down menu arrow to display other folders or files.

3 When Import... is selected, the image file dialog like that shown below will be displayed. Select the desired file format.
When "RAW" is first selected as the file format, the following window will open. Specify the width and height in terms of pixels, the depth (bit), and header size (byte).

- **Swap Bytes**: Specifies that the top and bottom bytes of the word should be switched when an image is taken up in Intel format.
- **Trade WH**: Switches the values for Width and Height.
- **Estimate**: Infers Width and Height using the original Depth and Header Size values.
When an image is opened, several windows will appear on it, like those shown below.

**Image window**
- Base window for image processing.

**Tool window**
- Window that contains the tools for selecting regions, etc., for magnification, scrolling, and other processing.

**View window**
- Window for confirming the entire image.

**Gradation adjustment window**
- Window for adjusting contrast, brightness, and gradation.

**Info. window**
- Window that displays the position of the tool on the image and the size of the enclosed ROI.

**Assist window**
- Window for fine adjustment of the position and size of the enclosed ROI.
4.4 Changing the Display

4.4.1 Changing the Display Color

Select Color Type from the Image menu and then select the desired monitor display command from the submenu that appears.

- Negative Gray: Displays in negative black and white (low-density regions are white; high-density regions are black).
- Positive Gray: Displays in positive black and white (low-density regions are black; high-density regions are white).
- 16 Color: Displays in 16 pseudo-colors.
- 32 Color: Displays in 32 pseudo-colors. (Brightness/Contrast is used to specify the colors for low- and high-density regions.)
- Red, Green, Blue: Displays fluorescent colors in 32 gradations.

4.4.2 Adjusting Gradation

Select Scale Type from the Image menu and then select the desired monitor display command from the submenu that appears.

- Linear: Adjusts contrast with a linear curve.
- Sigmoid: Adjusts gradation with a film-like tone curve.
- Triangular: Adjusts contrast with a serriform cyclic tone curve.
- Rectangular: Adjusts contrast with a rectangular waveform cyclic tone curve.
- Free Hand: Adjusts contrast with a free-hand tone curve.
- Equalization: Adjusts contrast with the tone curve automatically created by the software in accordance with histogram frequency.
2 Linear

Place the cursor inside the gradation bar in the above window and drag it with the (↑↓, ←→, ↔) adjusters.

Or, drag the brightness (B) and contrast (C) dials below the gradation bar.

Set values for each will be indicated in real-time. Brightness and contrast can be adjusted even if the adjusted bar inside the histogram is dragged.
3 Sigmoid

Place the cursor inside the gradation bar and drag it with the adjusters (as with Linear) or drag the Sigmoid dial below the gradation bar.

Set values will be indicated in real-time on the right side.

Brightness and contrast can be adjusted even if the adjusted bar inside the histogram is dragged.
With Sigmoid, not only can adjustment be done with the left-right adjuster bar but also with the up-and-down adjuster bar.

4 Triangular, Rectangular

Drag the phase (P) and frequency (F) dials.

Set values for each will be indicated in real-time.
5 Free Hand
Drag the \( \text{\textbullet} \) to create the tone curve.

6 Equalization
As shown in the following figure, the tone curve will be automatically drawn by the software.
4.4.3 Magnifying and Reducing the Image Display

The image display can be magnified and reduced using the following 2 methods.

1. Select Mag. Level from the Image menu and then select the desired magnification level from the submenu that appears.

```
<table>
<thead>
<tr>
<th>Mag. Level</th>
</tr>
</thead>
<tbody>
<tr>
<td>1:16</td>
</tr>
<tr>
<td>1:8</td>
</tr>
<tr>
<td>1:4</td>
</tr>
<tr>
<td>1:2</td>
</tr>
<tr>
<td>1:1</td>
</tr>
<tr>
<td>2:1</td>
</tr>
<tr>
<td>4:1</td>
</tr>
<tr>
<td>8:1</td>
</tr>
<tr>
<td>16:1</td>
</tr>
</tbody>
</table>
```

The numbers given are ratios of the number of pixels on the monitor to the number of pixels of the original image.

For example, for level 1:2 (monitor pixels: original image pixels), from 4 pixels of the original image, 1 pixel of the specific position is extracted and the image thinned out (reduced) by making it equal 1 pixel on the monitor.

2. Selecting the Magnifying Glass tool (🔍) from the tool window and clicking it in the image window to perform magnification and reduction.

Select the Magnifying Glass tool (🔍). Bring it inside the image window and it will change to (🔍) for magnification. Press the shift key and it will change to (🔍) for reduction.
4.4.3 Magnification and Reduction


About the image window when the magnification level has been raised:

When the magnification level is raised, the entire image region will not be able to fit within the image window. At this time, green and red regions will appear as something like the following in the view window shown below.

Green region: Indicates the region that can be displayed in the image window.
Red region: Indicates the region that is currently displayed in the image window.

Bring the cursor on the red frame, it will change to a  
You can move the red frame by dragging.
The image in the image window will be scrolled in realtime.

Bring the cursor on the green frame and the option key is pressed, it will change to a  
You can move the green frame by dragging.

When the green region is moved, the image in the image window will not be scrolled in realtime. Also, it will take more time than moving a red region.
4.4.4 Enhancing Contrast

1. Select Rangescope... from the Image menu.

Rangescope is a function for enhancing the contrast of 14-bit and other high-quantum image files by selecting the contrast portion you want to display.

When the contrast level of the targeted image is concentrated in a narrow range and Rangescope function is used on that narrow range to compress it, a sharper image can be obtained.

(Contrast can be adjusted by using the 8-bit gray scale on the compressed range. When using Rangescope function in color mode, 16 or 32 colors will be available.)

Rangescope function just changes the monitor display and not effects to the quantified values.

Rangescope function is not effective for 8 bits images or under.

2. The following window will appear.

--- Overview box Box that displays the entire image.

--- Scopeview box Box that displays the image within the vicinity of the Viewscope frame inside the Overview box.

--- Rangescope box Box that displays the intensity distribution of the image region from either the Overview box or the Scopeview box, depending on which has been selected.
3 Click inside the ◯ and select Overview or Scopeview. The selected one will change to ◯.

4 To move the Viewscope frame, place the cursor inside the Overview box, where it will change to ( CONCAT ). Click the desired place and the Viewscope frame will be moved to it.

5 There are two methods for compressing the range.
   (5-1) Value-based compression.
   (5-2) Compression by dragging the adjuster.

   (5-1) Value-based compression.
   Set the upper and lower limits of the QL value on the left of Rangescope box.
   Click the ◯ to set the values. Or, double-click inside the box that contains the values and the following window will appear, allowing you to make settings within it.

   (5-2) Compression by dragging the adjuster
   When the cursor is placed inside the Rangescope box, it will change to an adjuster, ＜＞. Drag the lower limit (red bar on the left side inside the Rangescope box) and the upper limit (blue bar on the right side inside the Rangescope box) to set them.
   (If you leave the cursor between the lower limit and the upper limit, the adjuster will change to, ＜＞. At this point, you can drag the lower and upper limit bars together with keeping an interval.)

6 After setting the upper and lower limits, click ［Apply ］ and the image window will change to show the adjusted image.
4.4.5 Clipping Out a Region

1. Using the Image Selector tool on the tool window, set the region you want to clip out.
   (When no region is specified, a copy of the entire image will be made.)

2. Select Clip Image from the Image menu.

3. When no region has been specified to be clipped out, the following confirmation window will appear.
4 The results of Clip Image will be displayed in a new window, as shown below.
(Image processing can be performed on the clipped-out portion. When the clipped-out portion is saved, image volume will correspond to the area that was clipped out.)

After Clip Image has been performed, the cursor will change to .
Click it and the image overlaid on the monitor can be moved up and down.
4.5 Measuring the Angle

1. Select the Angle tool from the Tool window that follows image display. (The cursor will change from to .)

2. In this condition, click the starting point of the angle to be measured on the image. With your finger released from the mouse button, move the mouse to the ending point and then click the mouse again there.

3. Measurement results will be displayed in the Info window, shown below.
Procedure for Modifying the Unit in which Angle is Displayed

Degree or Radian are the options available for selecting the unit in which angles are displayed.

1. Double-click the \( \angle \) Angle Tool. (The following Angle Tool Options dialog will be displayed.)

2. Click the desired unit for displaying angles to select it.

Note: It is not possible to draw more than 2 angle measurement lines at one time on one image. Drawing a new line will result in the automatic deletion of the line drawn before it.
5. Processing

5.1 Applying FFT

1. Double-click the Image Selector tool on the tool window. When FFT is applied, the number of pixels in the enclosed area must be expressed as a power of 2.

2. The following Marquee Options window will appear.

3. In the above window, specify the method for enclosing the area.
   - Free(Normal) While the Image Selector tool is moved on the window, the number of pixels will be shown as a power of 2. At this time, refer to the number of pixels for width and height specified in the Info. window.
   - Fixed The number of pixels for width (W) and height (H) of the Image Selector tool will be fixed. 
     The Image Selector tool moved on the screen will automatically express the number of pixels as $2^n$. 

Cursor position is viewed in terms of the standard (0, 0 — top left of the screen) and displayed in terms of the number of pixels from the left and the number from the top. The starting point of the enclosing frame is also viewed in terms of the same standard.
4 Select FFT... from the Process menu.

![FFT Options window]

5 The following FFT Option window will appear.

Select the desired window function.

The waveforms for each window function are shown below.

![Window Function waveforms]
Select the data type.

- **Data type**
  - QL
  - cnt

**QL** Quantum Level: Logarithm unit
**cnt (count):** Linear unit (shows the number of electrons)

However, for an image on which the following intra-image arithmetic is done, the unit will change from cnt to AU.

- A x B: multiplication, A/B: division, sqrt(A): deriving the root,
  - log(A): taking the logarithm.

- **Data type**
  - QL
  - AU

**AU** Arbitrary unit

Select whether to handle the image as a logarithm or not after FFT has been applied.

- 'Logarithm' image

To handle the image as a logarithm, click to change it to .
(The original data will remain as is.)

6 When is clicked, FFT will be conducted.
5.1.1 Applying the Circular Filter

The circular filter will be applied to eliminate background of the FFT image and obtain natural image (after inverse-FFT).

After FFT has been applied, select Filter from the Process menu and then Circular... from the submenu.

Enter the threshold value in the dialog opened as follows.

![Circular Options dialog]

If Filter is clicked, the Circular Filter will be applied.
5.2 Applying Inverse-FFT

Inverse-FFT will be applied to an image to which FFT has been applied. After FFT has been applied, all the tools in the tool window will be available for use.

1. Using the Mask tools in the tool window, set the frequency area for applying Inverse-FFT to an image to which FFT has been applied.
Double-click the Circle Mask tool. The following options window will open.

Set the circle radius in terms of pixels. Even after this has been done, the size of the circle can still be changed as desired on the screen.

Decide whether the selected region (effective area) will be inside the circle or outside it.

To resize, drag any of the 4 green points.
(b) Donut Mask tool

Double-click the Donut Mask tool. The following options window will open.

Set the radius of the circles inside and outside the donut in terms of pixels. Even after the radii have been set, the size of the circles can still be changed as desired on the screen.

Decide whether the selected region (effective area) will be inside the two circles of the donut or outside them.

To resize, drag any of the 4 green points.
(c) Twin Mask tool

Double-click the Twin Mask tool. The following options window will open.

Set the radius of the circles in terms of pixels. The radius can be modified even after it has been set by using this window. Even after the position of the circles has been set, it can be changed as desired on the screen.

Decide whether the selected region (effective area) will be inside the twin circles or outside them.

To resize, drag either of the 2 green points.
5.2 Applying Inverse-FFT

(d) Lane Mask tool

Double-click the Lane Mask tool. The following options window will open.

```
Lane Mask Tool Options

Width: [ ] (1 ... 100 : pix)

- Effective Area
  - Inside
  - Outside

[ ] Cancel [ ] OK
```

Set the lane width in terms of the number of pixels. Even after the lane width has been set, it can be modified in this window. Lane length and direction can be changed as desired on screen after settings have been made.

```
Width: [ ] (1 ... 100 : pix)
```

Decide whether the selected region (effective area) will be inside the lanes or outside them.

```
- Effective Area
  - Inside
  - Outside
```

To adjust lane width and direction, drag any of the 4 green points.
5.2 Applying Inverse-FFT

(e) Freehand Mask tool

1. Click on the toolbox to select Freehand Mask.

2. On the FFT image, drag from the starting point to the ending point. (If the starting point and ending point are not the same point, the software will automatically connect them.)

3. To set the Inside and Outside options for the Effective Area, double-click Freehand Mask, to call up the following Freehand Mask Options dialog.
(f) Array Mask lane

Double-click the Array Mask tool. The following options window will open.

![Array Mask Tool Options]

Select an odd number for the number of circles in 2 directions. On the screen, this will be shown as the first direction set \( \times \) (multiply) the next direction set.

Even after the number of circles has been set, it can be modified through this window.

Set the number of pixels for the radius of the circles.

Even after the circle radius has been set, it can be modified through this window.

After the direction and array width have been set, they can be changed as desired on the screen. Decide whether the selected region (effective area) will be inside the circles or outside.
1 To modify direction or array width, drag either of the 2 green vectors.

2 Select Inverse FFT... from the Process menu.

3 The following Inverse-FFT Options dialog will open.

   ![Inverse FFT Options dialog]

   In the above dialog, specify whether to display the Inverse-FFT image inside the image prior to applying FFT or to display it in the new window.

4 Click button. Inverse-FFT will be conducted.
5.3 Saving the FFT Image  

When the check button is clicked for **Keep FFT image** in the following window -- which is displayed when Inverse FFT is being used -- and leaving it selected, Inverse FFT will be performed with the FFT image saved as it is.

Note: This will not be possible if there is no available memory for saving the FFT image.
Eleven kinds of filters can be used.

- Low-pass filters (low-frequency pass filters) → Noise elimination and smoothing
  - Averaging
  - Median
- High-pass filters (high-frequency pass filters) → Line and edge detection and image sharpness
  - Gradient
  - Roberts
  - Sobel
  - Laplacian
  - Prewitt
  - Marr-Hildreth
  - High-Pass
  - High-Pass Enhances changes made on the original image (automatically processes arithmetic between images).
  - Unsharp mask
- Using a filter kernel that has been created as desired.
  - Custom

1. Double-click the Image Selector tool in the tool window.
2. The following Marquee Options window will appear.
3 In the above window, select the method for enclosing the area with a frame.
   Free (Normal) While the Image Selector tool is moved on the screen, the number of pixels will be expressed arbitrarily. At this time, refer to the number of pixels for width and height specified in the Info. window.

   Fixed The number of pixels for width (W) and height (H) of the Image Selector tool will be fixed.

   $2^n$ The Image Selector tool moved on the screen will automatically express the number of pixels as $2^n$.

4 Using the following procedure, conduct filter processing.

(a) Applying Averaging

Using the set kernel size (pixel x pixel), the average value is sought and that value becomes the value for the point of focus. This processing is done for the specified area. Select Filter from the Process menu and then select Averaging from the submenu that appears. The following Averaging Options window will open.
5.4 Applying Filter

Specify kernel size using odd numbers.

When others... is selected, the following window will open.

Set kernel size using odd numbers in the horizontal and vertical directions. After setting, click the OK button. It is possible to set the size to up to 1/8th of the image domain that was selected.
Select the averaging type.

- **Type**
  - Simple: Averaging will be done after assigning a coefficient of 1 to each pixel that makes up the kernel (simple averaging).
  - Gaussian: Averaging will be done after a weighted coefficient based on a regular distribution is applied to each pixel in the kernel.

Select the window in which to display the image after processing.

- **Show Result in**
  - Current Window: Displays image in the window it was displayed in prior to processing.
  - New Window: Displays image in a new window.

Click the **Filter** button and filtering will be performed.

(b) **Applying Median**

Arrange linearly the intensity of each pixel in the specified kernel size (pixel x pixel) and make the center value the value of the point of focus. This processing is done on the specified area. Select Filter from the Process menu and then select Median from the submenu that appears. The following Median Options window will open.
In the same way as for averaging, set kernel size and select the window that the image should be displayed in after processing and click the \textbf{Filter} button. Filtering will then be performed.

\section*{(c) Applying Gradient}
Move in the $x$ and $y$ directions the kernels that have the following coefficients.
Then, take the geometrical mean and conduct processing.

\begin{table}[h]
\begin{tabular}{ccc}
\hline
\textbf{$X$} & \textbf{$Y$} \\
\hline
0 & 0 & 0 \\
0 & 1 & -1 \\
0 & 0 & 0 \\
\hline
\end{tabular}
\end{table}

Select Filter from the Process menu and then select Gradient from the submenu that appears.
The following Gradient Options window will open.
Set the amplitude. The value input for the calculated value from filtering can be applied.

![Amplitude Input]

Select an offset value. The value input for the calculated value from filtering can be applied.

![Offset Input]

Select the effect type.

![Effect Type Options]

- **Emphasize**: The portion that has changed will be emphasized (Edge emphasis).
- **Detect**: Only the portion that has changed will be displayed (Edge emphasis).

Select the window the image should be displayed in after processing.

- **Current Window**: Displays image in the window it was displayed in prior to processing.
- **New Window**: Displays image in a new window.

When the **Filter** button is clicked, Filtering will be performed.
(d) Applying Roberts

Move in the x and y directions the kernels that have the following coefficients. Then, take the geometrical mean and conduct processing.

\[
\begin{array}{ccc}
0 & 0 & 0 \\
0 & 1 & 0 \\
0 & 0 & -1 \\
\end{array}
\quad
\begin{array}{ccc}
0 & 0 & 0 \\
0 & 1 & 1 \\
0 & -1 & 0 \\
\end{array}
\]

Select Filter from the Process menu and then select Roberts from the submenu that appears. The following Roberts Options window will appear.

As for Gradient, select the amplitude, offset value, effect type, and appropriate window; then, click the Filter button and filtering will be performed.
(e) Applying Sobel

Move in the x and y directions the kernels that have the following coefficients.
Then, take the geometrical mean and conduct processing.

\[
\begin{array}{ccc}
-1 & 0 & 1 \\
-2 & 0 & 2 \\
-1 & 0 & 1
\end{array}
\quad
\begin{array}{ccc}
-1 & -2 & -1 \\
0 & 0 & 0 \\
1 & 2 & 1
\end{array}
\]

Select Filter from the Process menu and then select Sobel from the submenu that appears.
The following Sobel Options window will open.

As for Gradient, select the amplitude, offset value, effect type, and appropriate window; then, click the Filter button and filtering will be performed.
(f) Applying Laplacian Use one of the 3 types of kernels with the coefficients shown below.

<table>
<thead>
<tr>
<th>Type1</th>
<th>Type2</th>
<th>Type3</th>
</tr>
</thead>
<tbody>
<tr>
<td>0 -1 0</td>
<td>-1 -1 -1</td>
<td>1 -2 1</td>
</tr>
<tr>
<td>-1 4 -1</td>
<td>-1 8 -1</td>
<td>-2 4 -2</td>
</tr>
<tr>
<td>0 -1 0</td>
<td>-1 -1 -1</td>
<td>1 -2 1</td>
</tr>
</tbody>
</table>

Select Filter from the Process menu and then select Laplacian from the submenu that appears.
The following Laplacian Options window will open.

Select the operator type.

As for Gradient, select the amplitude, offset value, effect type, and appropriate window; then, click the button and filtering will be performed.
(g) Applying Prewitt

Conduct processing by using the 8 types of kernels with the following coefficients and the template matching method.

\[
\begin{array}{ccc}
1 & 1 & 1 \\
1 & -2 & 1 \\
-1 & -1 & -1 \\
1 & 1 & 1 \\
1 & -2 & 1 \\
1 & -1 & -1 \\
1 & 1 & 1 \\
-1 & -1 & -1 \\
1 & -2 & 1 \\
1 & -1 & 1 \\
1 & 1 & 1 \\
\end{array}
\]

Select Filter from the Process menu and then select Prewitt from the submenu that appears.

The following Prewitt Options window will open.

As for Gradient, select the amplitude, offset value, effect type, and appropriate window; then, click the \text{Filter} button and filtering will be performed.
(h) Applying Marr-Hildreth

With the Marr-Hildreth option, processing will be done with kernels for which the Laplacian option to has been applied to Gaussian distribution. These coefficients will derive various values based on the number of pixels in the kernels.

The following formula can be used to derive the original coefficient.

\[ \nabla^2 G(r) = \frac{1}{\pi \sigma^4} \left( \frac{r^2}{2 \sigma^2} - 1 \right) \exp \left( -\frac{r^2}{2 \sigma^2} \right) \]

Select Filter from the Process menu and then select Marr-Hildreth from the submenu that appears. The following Marr-Hildreth Options window will open.

Select the kernel size, amplitude, offset value, and appropriate window; then, click the Filter button and filtering will be performed.
(i) Applying High-Pass

This filter is used to eliminate background components and enhance changes made on images.

Select Filter from the Process menu and then High-Pass from the submenu that appears. The following High-Pass Options window will open.

Select the kernel size, amplitude, offset value, and appropriate window; then click the **Filter** button and filtering will be performed.
With Unsharp Mask Options, changes made on the original image will be enhanced through the following processing done automatically.

Original image + a (original image subtracted by unsharp image)
* “a” above corresponds to the “amplitude” on the Unsharp Mask Options window shown below.

Select Filter from the Process menu and then Unsharp Mask from the submenu that appears.
The Unsharp Mask Options window as that shown below will appear.

Select the kernel size, amplitude, and appropriate window; then click the button and unsharp masking will be performed.
(k) Applying Custom

With Custom, a kernel with coefficients set arbitrarily by the operator is used for processing. Select Filter from the Process menu and then select Custom from the submenu that appears. The following Custom Matrix Kernels window will open.

As for averaging, set the kernel size. Also, set the scale value.

After processing, the value of the point of focus will be divided by the scale value. Set the offset value, select the window, and input the coefficients in the grid of the kernel.

Click the **Filter** button and filtering will be performed with the created kernels.

Click **Save** and the kernel will be saved (in text format).

Click **Load** and it will be possible to call up the kernel.
5.5 Inverting the Image Data

Pixel values composed the image can be converted(inverted). For the FFT images and the Contour plot images, this function is not available. When the image data pixel is 16384 gray level (14 bit), each pixel will be converted as follows.

<table>
<thead>
<tr>
<th>Before converting</th>
<th>After converting</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>16384</td>
</tr>
<tr>
<td>1</td>
<td>16383</td>
</tr>
<tr>
<td>...</td>
<td></td>
</tr>
<tr>
<td>16383</td>
<td>1</td>
</tr>
<tr>
<td>16384</td>
<td>0</td>
</tr>
</tbody>
</table>

1. Open the target image.
   Specify the target region. (If you have not specified any region, all the region will be inverted.)

2. Select Invert Pixel... from the Process menu.

   ![Invert Pixel Options](Image)

   The following Invert Options window will open.

   ![Invert Options](Image)

3. Select the window in which to display the image after processing.

   ![Select Window](Image)

4. Click the Invert button to invert the image (region).
5.6 Filtering the Hot / Cold Spot

When white/black spots appear on the read image causing the detector’s pixel failure, you can remove (filter) them using this function.

1. Open the target image and specify the target region. (If you have not specified any region, all the region will be filtered.)

2. Select Hot/Cold Spot Filter... from Process menu.

The following Hot/Cold Spot Filter window will open.

3. Input the filtering constant.

If the spots is in higher level (Hot spot), first the difference (a) between the target pixel and the maximum pixel around the target pixel is obtained, then (a) and the difference between maximum pixel and minimum pixel around the target pixel will be compared.

If "10" is input as a constant, the target pixels (spots) will be removed when (a)>(b)x10 is satisfied.
5.6 Filtering the Hot / Cold Spot

4. Select the window in which to display the image after processing.

5. Click the Filter button to execute this function.

Example of Effection
5.7 Rotate Function

1. Using the Image Selector tool in the tool window, set the area to be rotated.
   (If no area is set, the entire image will be rotated.)

2. Select Rotate... from the Process menu.

   The following Rotate Options window will open.

   ![Rotate Options window]

   Set the angle of rotation.

   ![Angle input field]

   Set the display magnification to follow rotation.

   ![Magnification input field]
5.7 Rotate Function

Set the direction of rotation.

- Direction
  - CW Rotation will be clockwise.
  - CCW Rotation will be counterclockwise.

Select the image interpolation method to follow rotation.
(Interpolation will be done on the pixel of the non-lattice point following rotation)

- Interpolation
  - Nearest Neighbor
  - Bi-linear
  - Bi-cubic

Nearest neighbor: The density of the lattice point for the uv coordinates closest to the non-lattice point \((u_0, v_0)\) will be set as the value for \((u_0, v_0)\).

Bi-linear: Using the densities of 4 lattice points around the non-lattice point \((u_0, v_0)\), the density for \((u_0, v_0)\) is interpolated linearly.

\[
f(u_0, v_0) = (1-a)(1-b)f(u',v') + af(u'+1,v') + (1-a)b f(u',v'+1) + ab f(u'+1,v'+1)
\]

\(u' = u_0, v' = v_0, a = u_0 - (u_0), b = v_0 - (v_0)\).

(w) expresses the maximum integer that does not exceed w.

Bi-cubic: Using the densities of 16 lattice points around \((u_0, v_0)\), cubic interpolation is done.

Here \((u_0, v_0)\) is a lattice point around \((u_0, v_0)\) and interpolative coefficient c(x) is defined linearly.

\[
f(u_0, v_0) = \sum_{(u',v') \in \mathbb{Z}^2} f(u',v') c(1-u' u_0) c(1-v' v_0)
\]

Function c(x) is piecewise three-dimension polynomial approximation of function \(\sin x / x\) that is revealed with the sampling theorem for continuous signals.
5.7 Rotate Function

Select the window the image should be displayed in after processing. Also, activate (check) "Clip to source area size."

3. Click the button to conduct rotation.

- When Clip... has not been checked.
- When Clip... has been checked.
The result of the last angle measured when image rotation functions were used will be set as the default value for the rotation angle for image rotation.

The smallest result of angle measurement, which in the above example is the angle that will serve as the X axis, will become the default value for "Angle" in the Rotate Options dialog.

From the above example, 42.198 degree will be set as the default for "Angle."

[Diagram showing the Rotate Options dialog with the Angle set to 42.198]
5.8 Flip Function

1. Using the Image Selector tool in the tool window, define the area to be flipped.
   (If no region is defined, the entire area will be flipped.)

2. Select Flip... from the Process menu.

The following Flip Options window will open.
Select the direction of flipping.

Horizontal Area will be flipped horizontally.
Vertical Area will be flipped vertically.

Select the window the image should be displayed in after processing.

3 Click the button and flipping will be done.
5.9 Joint Function

1. Open the entire image that you want to attach.
   * Only image of the same size and density resolution can be attached.

2. Select Joint... from the Process menu.

   The following Joint Options window will open.

   Select the direction in which you want to attach the image.

   **Horizontal** Image will be attached horizontally.
   **Vertical** Image will be attached vertically.
Select the image that you want to joint.

Selection can be made from the pulldown menu.

3 Click the button to joint the image.
5.10 Modifying the Image Aspect Ratio

This function is used to modify an image's vertical-to-horizontal ratio. It is effective for correcting distortion and the like in images obtained from external detection devices.

1. Select the image domain for processing and then select Aspect Ratio... from the Process menu. The following Aspect Ratio Options dialog will be displayed.

![Aspect Ratio Options dialog]

Original Size:

X: 800  Y: 904

Converted Size:

X: 800  Y: 904

Interpolation:

- Nearest Neighbor
- Bi-Linear
- Bi-Cubic
Original Size: Original size of the select domain (unit: pixels).

Converted Size: Input the desired post-modification size (unit: pixel).

Interpolation: Select the type of interpolation desired at time of modification.

Nearest Neighbor: Sets the density for the lattice point of the uv coordinates that are closest to non-lattice point \((u_0, v_0)\) as the value for \((u_0, v_0)\).

Bi-Linear: Using the densities of the 4 lattice points surrounding non-lattice point \((u_0, v_0)\), the density of \((u_0, v_0)\) is interpolated via the following formula.

\[
f(u_0,v_0) = f(u',v')(1-a)(1-b) + f(u'+1,v')a(1-b) + f(u',v'+1)(1-a)b + f(u'+1,v'+1)ab
\]

\(u'=(u_0), \ v'=(v_0), \ a=(u_0)-(u_0), \ b=(v_0)-(v_0)\).

(w) expresses the maximum integer, which will not exceed w.

Bi-Cubic: Using the densities of the 16 lattice points surrounding \((u_0, v_0)\), 3-dimensional interpolation is done.

\[
f(u_0, v_0) = \sum_{x} \sum_{y} \sum_{z} f(u_x, v_y, v_z) c(u_x - u_0) c(v_y - v_0) c(v_z - v_0)
\]

Here, \((u_x, v_y)\) is a lattice point surrounding \((u_0, v_0)\).

Interpolation coefficient \(c(x)\) is defined with the following formula.

\[
c(x) = \begin{cases} 
1 - 2|d|^2 + |d|^3 & 0 \leq |d| < 1 \\
4 - 8|d|^2 + 5|d|^3 & 1 \leq |d| < 2 \\
0 & 2 \leq |d|
\end{cases}
\]

Function \(c(x)\) is a divided 3-dimensional polynomial expression approximation of function \(\sin x / x\), which appears in continuous signal sample processing.

2 Click Process to implement.
5.11 Using Arithmetic

1. Open the entire image you want to use arithmetic on.
   * Intra-image arithmetic can only be performed on images of the same size and density resolution.

2. Select Arithmetic... from the Process menu.

   The following Arithmetic Options window will open.

   ![Arithmetic Options Window]

   - Operation: Select the desired operation (e.g., A + B).
   - Offset: Enter the offset value.
   - Image A and Image B: Select the images to be processed.
   - Multiplication coefficient: Enter the coefficient for multiplication.
   - Constant: Enter the constant value.
   - Data Type: Select the data type (Pixel Data or Converted Data).
   - Position Matching Type: Select the position matching type (Automatic or Manual).

Select the desired type of arithmetic.
### 5.11 Using Arithmetic

**Operation:**
- $A + B$
- $A - B$
- $A \times B$
- $A / B$
- $A \times A / B$
- $A + \text{const}$
- $A - \text{const}$
- $A \times \text{const}$
- $A / \text{const}$
- $\sqrt{A} \times \text{const}$
- $\log(A) \times \text{const}$

- **A+B:** Addition, **A-B:** Subtraction, **AxB:** Multiplication, **A/B:** Division
- **AxA/B:** Multiplication and division done at one time
- **A+const:** Add a constant, **A-const:** Subtract a constant,
- **Axconst:** Multiply by a constant, **A/const:** Divide by a constant,
- **sqrt(A) x const:** Take the root and multiply by a constant,
- **log(A) x const:** Take the logarithm and multiply by a constant.

Input the offset value (the pixel (QL) value to be added to image data after processing).

<table>
<thead>
<tr>
<th>Offset</th>
<th>0</th>
</tr>
</thead>
</table>

Input the amplitude for the image and image data on which arithmetic was done.

<table>
<thead>
<tr>
<th>Image A</th>
<th>Image B</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1" alt="Hrem1.png" /></td>
<td><img src="image2" alt="Ideflect.png" /></td>
</tr>
<tr>
<td>× $\text{1.000000}$</td>
<td>× $\text{1.000000}$</td>
</tr>
<tr>
<td>(0.0 .. 1000000.0 : real number)</td>
<td>(0.0 .. 1000000.0 : real number)</td>
</tr>
</tbody>
</table>

The image to undergo arithmetic can be selected from the pulldown menu.

<table>
<thead>
<tr>
<th>Image A</th>
<th>Image B</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image3" alt="Southern.png" /></td>
<td><img src="image2" alt="Ideflect.png" /></td>
</tr>
<tr>
<td>× $\text{1.000000}$</td>
<td>× $\text{1.000000}$</td>
</tr>
<tr>
<td>(0.0 .. 1000000.0 : real number)</td>
<td>(0.0 .. 1000000.0 : real number)</td>
</tr>
</tbody>
</table>

When performing arithmetic that involves a constant, input a value for the constant.

<table>
<thead>
<tr>
<th>Constant</th>
<th>1.000000</th>
</tr>
</thead>
<tbody>
<tr>
<td>(−1000000.0 .. +1000000.0 : real number)</td>
<td></td>
</tr>
</tbody>
</table>
Select the data type to be used in the arithmetic.

Data Type:
- QL (Pixel Data): Arithmetic done with QL (pixel) value.
- AU (or cnt or PSL): Arithmetic done with linear value.
- * The AU portion will display the unit of the image being handled.

Select whether or not to use the function for matching the position between images. To select this function, specify the position matching type.

Position Matching Type:
- None: Not to match the position.
- Spot mark: Semi-automatic position matching using the markspot tool.
- Line mark: Semi-automatic position matching using the markline tool.

Select the window to show the results of arithmetic in.

Show Result in:
- New Window: Results will be displayed in a new window.
- Image A Window: Results will be displayed in one of the image windows (A) used in the arithmetic.
- Image B Window: Results will be displayed in one of the image windows (B) used in the arithmetic.

3 Click the button to perform arithmetic.
5.12 Overlapping the Image Manually

While viewing two images overlapping with each other, manually match the position.

1. Open the images for intra-image calculation.

   * This means to open any but a Contour Plot or FFT image.

2. Select Arithmetic... from the Process menu.

3. On the Arithmetic Options dialog thus opened, specify necessary items and select Manual in Position Matching Type:

4. If the Calc button is clicked, the following Matching dialog will be displayed.
On the dialog shown above, Image B overlaps Image A.

If the Calc button is clicked, arithmetic calculation will be performed.

Overlapping Image B can be moved by dragging. If the angle should be adjusted, enter the rotation angle and click or , and overlapping Image B will rotate.

5 Clicking the Detail button will display the magnified image as shown below.

If the Calc button is clicked, arithmetic calculation will be performed.
5.13 Overlapping the Image Semi-automatically

This function is for semi-automatic overlapping of the space between two images (of the same sample) for intra-image arithmetic. The Markspot tool and Markline tool can be used.

Markspot tool: Aligns the position between two images.
Markline tool: Aligns the position/angle between two images.

(a) Markspot tool

1. Open the images for intra-image calculation.
   * This means to open any but a Contour Plot or FFT image.

2. Using the Markspot tool, specify the portion that will serve as the standard for image overlapping.

   1) Double-click the Markspot tool on the Tool window. The following dialog will be displayed.
Here, select Markspot Area Size.

Markspot Area Size: At time of overlapping, a rectangle is created using Markspot as the center, and intra-image overlapping is done via relative calculation from within that area. Markspot Area Size indicates the size of the rectangle used at that time.

- Small: Creates a rectangle with 200 pixels on 1 side.
- Medium: Creates a rectangle with 400 pixels on 1 side.
- Large: Creates a rectangle with 600 pixels on 1 side.

2) After Mark Spot Area Size has been selected, place the Markspot on the portion that will serve as the standard for overlapping the area between two images (that is, on a portion that is common to both images).
3) For the image that corresponds to the head of the left side of the image arithmetic formula (for A - B, it would be image A, for example), use the Enclosure tool from the Tool window to specify the area between the images that you wish to calculate.

* The Markspot does not need to be within the area to be calculated.
* For the image that corresponds to the head of the right side of the image arithmetic formula (for A - B, it would be image B, for example), after relative calculation of the space between two images, the calculated area will be automatically set.
* If no area has been specified, the entire area will be subjected to calculation.
4) Select Arithmetic... from the Process menu.

The following Arithmetic Options dialog will be displayed.

Position Matching Type:
Select Spot mark.
Auto Adjust:
On: Performs position alignment using relative calculation.
Off: Performs position alignment between two images using Markspot position and without performing relative calculation.

5) Click here to perform intra-image arithmetic using position alignment with the Markspot tool.
(b) Markline tool

1. Open the images for intra-image calculation.
   * The images referred to here are those other than Contour Plot and FFT images.

2. Using the Markline tool, set a portion that will serve as the standard for total-image overlapping.

   1) Double-click the Markline tool in the Tool window. The following dialog will be displayed.

   ![Image of Markline tool]

   Select Markline Area Size here.

   Markline Area Size: At time of overlapping, a rectangle is created focusing on Markline's starting point and ending point. In that region, with relative calculation, intra-image overlapping is done. Sizes of the rectangles created are defined as follows:

   - **Small**: Creates a rectangle with 200 pixels on one side.
   - **Medium**: Creates a rectangle with 400 pixels on one side.
   - **Large**: Creates a rectangle with 600 pixels on one side.
2) After selecting Markline Area Size, create the Markline using 2 points (Markline’s starting point and ending point) from the portion that serves as the standard for 2-image overlapping (the area between the two images that is jointly shared).

Place the Markspot on the portion that serves as the standard for 2-image overlapping.
3) For the image that corresponds to the head of the left side of the image arithmetic formula (for A-B, it would be image A, for example), use the Enclosure tool from the Tool window to specify the area between images that you wish to calculate.

* The Markline does not need to be within the area calculated.
* For the image that corresponds to the head of the right side of the image arithmetic formula (for A-B, it would be image B, for example), after relative calculation of the space between two images, the calculated area will be automatically set.
* If no area has been specified, the entire area will be subjected to calculation.
4) Select Arithmetic... from the Process menu.

The following Arithmetic Options dialog will be displayed.

Position Matching Type :
Select Spot mark.
Auto Adjust:
On: Performs position/angle alignment using relative calculation.
Off: Performs position/angle alignment between two images using Markline position as the standard and without performing relative calculation.

5) Click here to perform intra-image arithmetic after position/angle alignment using the Markline tool.
When there is pixel overflow or underflow for each type of filter or intra-image arithmetic result, a dialog like the following will be displayed.

![NOTE! The new image has some overflowed or underflowed pixels.](image)

overflow: 0 pixels (65536 pixels)
underflow: 35279 pixels (65536 pixels)
5.15 Displaying Composed Fluorescent Images

1. Open images you want to compose and display. Display each image in fluorescent colors.

2. Select Compose... from the Process menu.

3. On the Compose Option dialog, select images you want to compose and display.

   * Image A and Image B must be displayed in different fluorescent colors.

4. If the button is clicked, the Compose dialog as shown below will be displayed.
On the dialog shown above, Image B overlaps Image A.

If the **Compose** button is clicked, images will be composed and displayed.

Overlapping Image B can be moved by dragging. If the angle should be adjusted, enter the rotation angle and click **Counterclockwise rotation** or **Clockwise rotation**, and overlapping Image B will rotate.

5 Clicking the **Detail** button will display the magnified image as shown below.

If the **Compose** button is clicked, images will be composed.

* Composed images cannot be saved. Image processing will not be possible with composed images, although those images can be exported to the BMP file on TIFF file
5.16 Displaying the Contour Line

1. Using the Image Selector tool in the tool window, set the area for which you want to display the contour line.

2. Select Contour Plot... from the Process menu.

The following Contour Plot Options window will be displayed.
Select the unit in which the contour line should be displayed.

QL (Quantum Level) Logarithm unit
cnt (count) Linear unit (shows the number of electrons).

However, for an image on which the following intra-image arithmetic is done, the unit will change from cnt to AU.

A x B: multiplication, A/B: division, sqrt(A): deriving the root,
log(A): taking the logarithm.

AU Arbitrary unit

Set the number of lines for the contour line, up to a maximum of 16.

The number of lines can be set from the pulldown menu.

At first, the triangle marker will overlap the setting for number of lines, as shown below.
Drag the triangle marker to the desired position. At this time, the value for the triangle marker will be shown within the Value box in terms of the specified unit (here, QL).

After setting the maximum and minimum values for the contour line, click the Equalize button. The space between the maximum and minimum values will be divided uniformly with the selected number of contour lines. (In this example, 4 contour lines were used.)

If an arbitrary value is input for Value, the triangle marker will move to the position of the input value.

Select the display color for the contour line.

3 Click the Pct button and the contour line will be made.
6. Displaying Multiple Images

When multiple images have been opened, the following 2 display methods can be used.
(a) Cascade Images are displayed in staggered form.
(b) Tile Images are displayed lined up like tiles.

(a) Cascade

1. Select Cascade from the Window menu.

The display will be something like the following.
(b) Tile

1. Select Tile from the Window menu.

The display will be something like the following.
7. Saving

The following 3 methods can be used for saving.

(a) Save  The image will be overwritten and saved or newly saved after processing that involves changes in pixel values.
(b) Save as  Saves the image in another name.
(c) Export  A portion of the image is clipped out and saved in another format.

(a) Save

1. Select Save... from the File menu.

Specify the destination for saving in the open dialog.

(b) Save as

1. Select Save as... from the File menu.

Assign name and specify the destination for saving in the Open dialog.

(c) Export

1. Select Export... from the File menu and then select file format from the submenu.
BMP: Converts to a bit map file while maintaining the number of pixels of the original image.

TIFF: Converts to a TIFF file.

The following dialog will be displayed.

![Export TIFF](image)

Select resolution for saving the image.

Window: Converts to a TIFF file while maintaining the pixel size of the original image.

Original (8bit): Converts to an 8-bit-grey TIFF file without thinning out the pixel size from original image. If the original data is the 2byte-data, decreases gradations to the upper/lower limit value on Range Scope to convert it to a TIFF file.

Original (16bit): Converts to a TIFF file without thinning out the pixel size from the original image. For 8bit data, this function cannot be selected.

RAW: Converts to raw image.

The following dialog will be displayed while the image is saved.

![Raw Export Options](image)

Original Depth: Saves the image while maintaining the number of gradations of the original image.

8-bit Depth: If the original image is 2-byte data, decreases gradations to the upper/lower limit value on Range Scope to convert it to a TIFF file.

Select either one and click OK to determine selection.
8. Undoing Processing

This function can be used to undo the previous process.

1. Select Undo from the Edit menu.

![Edit Menu]

The previous process will be undone.

* Undo can only be used to undo the previous process when no other method is available.

For example, in magnification processing, Undo cannot be used because reduction processing can be used to fulfill the same function.

To reverse all image processing and restore the image to its original state, select Revert from the File menu.

![File Menu]

The original image will be restored.
9. Viewing Image Information

1. Select File Info... from the File menu.

The following File Information screen will open.

To close this window, click inside it.
10. Printing

10.1 Printing Image on Laser Beam Printer

1. Activate the window of the image that you wish to print.

2. Select Print Setup... from the File menu and select paper settings.

3. Select Print... from the File menu to print.
10.2 Easily Printing Images Out on Pictrography 3000 / Pictrography 3500 / Pictrography 4000 or Pictrostat 400

1. Activate the window of the image that you wish to print.

2. Select Print Pictro... from the File menu.

3. The following dialog will be displayed.

* The paper size will differ depending on the printer (PG3000 / PG3500 / PG4000 / PSD400) connected and the paper type. The dialog shown above represents an example when PG4000 has been selected.
Window: Displays the name shown in the window header of the image targeted for printing.
This name will be printed out as additional information on the bottom left of the printing paper, in black.
Printing position will be as follows. (Character size is fixed.)

* The arrows indicate the direction of the top of the image on CRT display.

Image Size: Displays the size of the image targeted for printing.
Print Type:
1:1 Pixel (Display Mag.)
Prints image using the image display magnification ratio.
* The size will change depending on the image display magnification ratio effective at the time (which will be displayed in parentheses at the end of the image name).
1 : 1 -> Prints with 1 pixel of image data corresponding to 1 pixel on Pictrography.
1 : 2 -> Prints with 2x2 pixels of image data corresponding to 1 pixel on Pictrography.
2 : 1 -> Prints with 1 pixel of image data corresponding to 2x2 pixels on Pictrography.
* The size of the image to be printed out will differ with the image display magnification ratio. Thus, select the image magnification ratio prior to printing.
Example: When display magnification ratio of 1:1 and A4 paper size are selected for an image of 3000x3760 pixels, the image will be printed out so that it takes up nearly the entire surface of the paper.

1:1 image Prints images in actual sizes.
The vertical and horizontal sizes can be finely adjusted using the Adjust Width / Adjust Height function.

Paper Size: Indicates the size of paper used for printing out the image.
* The paper size differs depending on the printer that is connected. In the case of PG4000 or PSD400, the paper size is automatically determined by the width of the paper being loaded.
4. After selecting Paper Size, click [Print].

5. The following dialog will be displayed and the sending of data to Pictrography will begin.

* When the size of the image targeted for printing is larger than the size of the paper, a warning dialog like the following will be displayed, and only the area of the image that will fit inside the paper from the center out will be printed.